PAC Project R9.2000

March 9, 2012

Contents
PAC Control, page 3
PAC Redundancy Manager, page 31
PAC Display, page 32
OptoOPCServer, page 77
PAC Manager, page 88
OptoDataLink, page 107
PAC Utilities, page 109
How to Get Help

What's new for PAC Project R9.2000?

PAC Control. Eleven new commands have been added. Support has been added for the G4EB2 brain board (also includes part numbers G4D32EB2 and G4D32EB2-UPG), the SNAP-SCM-CAN2B serial communications module, the SNAP-IDC-32D digital input module, and the SNAP-OMR6-A and SNAP-OMR6-C mechanical relay output modules. Bugs described in KB articles KB81597, KB81624, KB81839, KB81840, and KB81847 have been fixed.

PAC Display. You can now add a control engine-driven dynamic attribute to text on a Windows button. The new AutoCorrect Tags option on the Configurator Options dialog box allows AutoCorrect Tags to either include or exclude tags inside grouped graphics (excluded by default). The bugs described in the following KB articles have been fixed: KB81316, KB81592, KB81693, KB81727, KB81853, KB81729, KB81743, KB81801, and KB81883.

PAC Manager. Added support for the G4EB2 brain (including part numbers G4D32EB2 and G4D32EB2-UPG) and the SNAP-IDC-32D, SNAP-OMR6-C, and SNAP-OMR6-A modules. The bug described in KB article KB81848 has been fixed.

OptoOPCServer. Added new Item IDs for pulsing, point configuration, diagnostic status read area items, and SNMP. The bug described in KB article KB81856 has been fixed.

Questions
If you have questions, see How to Get Help.

KB numbers
A number with the prefix "KB" next to an item in this readme, such as KB49909, refers to an Opto 22 KnowledgeBase. A KB article provides additional information about a feature or bug. To find a particular KB article, go to the Opto 22 website, http://www.opto22.com, and enter the KB number in the search engine. To browse the entire list of KB articles, go to http://www.opto22.com/site/knowledgebase/kb_index.aspx.

NOTE: If a referenced KB article has a hyperlink, you can click on it and go directly to the article. However, if a referenced KB article does not have a hyperlink, the article was not yet available when this readme was published.

Previous Versions of PAC Project
In PAC Control, commands were added to send emails, post web content, get the date and time, and more. Support was added for the SNAPSCM-SSI module as an Analog Input. In PAC Manager support was added for SNAP-AITM-4i and SNAP-AIRTDAI

PAC Project Version R9.0000 (June 14, 2010):
Added support for controller-level redundancy when used with the SNAP PAC Redundancy Option Kit, part number SNAP-PAC-ROK.

For PAC Project Version R8.1000 (October 12, 2007):
Added support for the following new Opto 22 devices:
* SNAP-PAC-S2 Controller
* SNAP-PAC-SB1 and SB2 serial brains

Added support for the following new SNAP I/O modules:
* SNAP-AIMA-8, 8-channel analog current input, -20 to +20 mA
* SNAP-AIV-8, 8-channel analog voltage input, -10 to +10 VDC or -5 to +5 VDC
* SNAP-AICTD-8, 8-channel analog temperature input, ICTD

For PAC Project Version R8.0000 (March 1, 2007)
Changed name to PAC Project. PAC Project Basic includes the Basic versions of PAC Control, and PAC Display, as well as PAC Manager, which are very similar to the previous ioControl, ioDisplay, and ioManager, although they add new features and support for several new modules and brains.

PAC Project Pro includes the Pro versions of the PAC Project applications as well as OptoOPCServer. In addition, PAC Project Pro now includes OptoDataLink for exchanging SNAP PAC System data with databases (including Microsoft SQL Server, Microsoft Access, and MySQL), text files, and email systems.

For ioProject Version R7.1000 (March 8, 2006):
Added support for the SNAP-PAC-R1 and SNAP-PAC-R2.

General Note about Windows XP:
If you run ioProject applications in Microsoft Windows XP, make sure to use the Windows Classic theme. Otherwise, a Microsoft bug with how themes are handled may cause the system to crash.

To correct the problem:
1. Right-click on an empty part of the Desktop.
2. Select Properties.
3. With the Themes tab selected, choose the Windows Classic theme.
4. Reboot to get a clean start.

For ioProject Version R7.0006 (January 12, 2006):
Added the ability to install both ioProject Professional and ioProject Basic on the same computer.

For ioProject Version R7.0000 (December 12, 2005):
What's New in ioProject 7?

Version 7.0 of Opto 22’s ioProject software suite for industrial automation, remote monitoring, and data acquisition applications introduces two forms of the software suite: ioProject Basic and ioProject Professional. Additional

major changes in this version include support for new SNAP PAC controllers.

ioProject Basic
---------------
ioProject Basic provides ioControl Basic for developing control programs, or strategies, and ioDisplay Basic for developing operator interfaces (HMIs). ioManager software is also included for configuration.

ioProject Basic comes with your purchase of a SNAP PAC or SNAP-LCE controller, or a SNAP Ultimate, SNAP Ethernet, or SNAP Simple brain. It can also be downloaded from our website, www.opto22.com. Full documentation is provided in Adobe Acrobat PDF format.

ioProject Professional
----------------------
ioProject Professional includes ioControl Professional for developing control strategies, ioDisplay Professional for developing operator interfaces (HMIs), and OptoOPCServer for communicating with OLE for Process Control (OPC) 2.0 clients. ioManager software is also included for configuration.

ioProject Professional is designed for more complex projects, especially those requiring OPC, multiple protocol, multiple network, or legacy hardware support. ioProject Professional is designed for use with SNAP PAC controllers and takes advantage of their features, including dual independent Ethernet network interfaces for redundant Ethernet links or segmented networking.

ioProject Professional can be purchased as a complete suite or as individual applications. It can be downloaded from our website for immediate use and is also shipped to you on a CD with full documentation in both PDF and printed form.

Information in this README file applies to both versions of ioProject unless otherwise indicated with [BAS] or [PRO].

PAC Control

PAC Control Professional R9.2a
PAC Control Basic R9.2a
PAC Project R9.2000
February 29, 2012

New Features:
The following commands have been added:
- Set Time Zone Configuration
- Get Time Zone Offset
- Get Time Zone Description
- Synchronize Clock SNTP
- Convert Date & Time to NTP Timestamp
- Convert NTP Timestamp to Date & Time
- Float to Int32 Bits
- Int32 to Float Bits
- Receive Numeric Variable
- Receive Numeric Variable Ex
- Bit Copy
**Enhancements:**

Support has been added for the following new products:

- G4EB2 brain board (also includes part numbers G4D32EB2 and G4D32EB2-UPG)
- SNAP-SCM-CAN2B serial communications module
- SNAP-IDC-32D digital input module
- SNAP-OMR6-C and SNAP-OMR6-A mechanical relay output modules

In Strategy archives, auto-archives are now enabled on new strategies, and all archives are stored in a sub-directory named "Archives."

**Bug Fixes:**

- **KB81597** - A problem has been corrected when using an Action block and the Move command to move an Integer 64 literal or variable into a timer variable. When executed, it would cause the controller to reset.
- **KB81624** - A problem has been corrected when compiling strategies or entering Debug mode when logged into Windows with a roaming user profile.
- **KB81839** - A problem has been corrected where not all text was visible in some dialog boxes when running PAC Control in the Chinese version of Windows.
- **KB81840** - A problem has been corrected when entering Chinese characters into an OptoScript block.
- **KB81847** - A problem has been corrected when entering Chinese characters into a tag name.

**PAC Control Professional R9.1c**
**PAC Control Basic R9.1c**
PAC Project R9.1003
October 14, 2011

**New Feature:**

Added support for the SNAP-IDC-32DN module.

**Bug Fixes:**

- **KB81503** PAC Control may not open a PDF with the default PDF viewer.
- **KB81511** Some error messages are missing from PAC Project Software R9.1.

**PAC Control R9.1b**
PAC Project R9.1002
September 16, 2011

**Bug Fixes:**

- **KB81430** Imported I/O points missing or behave incorrectly in strategy.
Renaming a tag or using Find and Replace within Tag Names causes OptoScript errors.

PAC Control R9.1a
PAC Project R9.1000
July 18, 2011

New Features:

The following commands have been added:

- HTTP Get
- HTTP Post from String Table
- HTTP Post Calculate Content Length
- Send Email with Attachments
- Trim String
- Get & Restart Timer
- Get Date & Time
- Send Email

These commands require controller firmware R9.1b.

Enhancements:

- Added support for the SNAP-SCM-SSI module as an Analog Input.
- Added support for the SNAP-AIRTD-1K analog temperature input module.
- Added support for the SNAP-AITM-4i thermocouple analog input module.
- Changed default scaling for SNAP-AIPM-3 and SNAP-AIPM-3V three-phase power modules. Voltage input for the SNAP-AIPM-3 module has changed from 0-250 to 0-300 V. Voltage input for the SNAP-AIPM-3V module has changed from 0-250 to 0-300 V. Current input for the SNAP-AIPM-3 has changed from 0 - 10 A to 0 - 5 A.
- PAC Control now detects when a dialog will be off the screen, either because the resolution has been reduced or because a secondary monitor is no longer in use.

Bug Fixes:

KB81091 Converted OptoControl strategies have incorrect initial values for numeric variables and tables.

KB81006 'Autocreate Points' configures some analog modules incorrectly.

KB81326 When editing a Pointer variable, the Persistent option is shown incorrectly.

PAC Control R9.0g
PAC Project R9.0006
September 3, 2010

Bug Fixes:

KB81005 B100 I/O units cannot be imported into a strategy.
KB81077 Lost online changes and controller problems caused by 'Start Alternate Host Task' command.

=====================================================================  
PAC Control R9.0f  
PAC Project R9.0004  
August 20, 2010

Bug Fixes:

KB81059 PAC Control connection lines disconnecting from objects.

KB81061 Some PAC Control compiler errors are not reported.

=====================================================================  
PAC Control R9.0e  
PAC Project R9.0002  
July 22, 2010

New Feature:

Added the Clear I/O Unit Configured Flag command.

Bug Fixes:

KB81022 Cannot type in negative Int32 literals in Add Instruction dialog.

KB81024 Digital reaction cannot be configured for Mistic event/reaction.

=====================================================================  
PAC Control R9.0d  
PAC Project R9.0002  
June 29, 2010

Enhancement:

Added scalable mode for the SNAP-AIRTD-10 module.

Bug Fix:

KB81000 PAC Control may crash when regenerating reference counts.

=====================================================================  
PAC Control R9.0c  
PAC Project R9.0001  
June 22, 2010

Bug Fixes:

KB80994 Double-clicking title bar in PAC Control does not minimize/maximize window.

KB80992 PID loop parameters are not displayed in PAC Control Watch window.

KB80991 NAP-AIRTD-8D and SNAP-AIRTD-10 modules unknown in PAC Control.
PAC Control R9.0b
June 18, 2010
[Basic only]

Bug Fix:

KB80990 Problems running PAC Control Basic R9.0.

PAC Control R9.0a
PAC Project R9.0000
June 21, 2010

New Features and Enhancements:
----------------------------------
Many new features are included in PAC Control Professional in support of controller-level redundancy when used with the SNAP PAC Redundancy Option Kit, part number SNAP-PAC-ROK. This includes the following features:

* The Ability to create strategies that use redundant controllers

* A new PAC Redundancy Manager in PAC Control manages, monitors, and commissions components in redundant controller system.

* A Sync Block Tool allows you to insert sync blocks in a chart in order to synchronize redundant controllers at strategic places in a chart's logic.

PAC Control Basic adds many subroutine types, digital features options, and commands previously available only in PAC Control Professional.

There are three new analog simulation commands: IVAL Set Analog Filter Value, IVAL Set Analog Min Value, and IVAL Set Analog Max Value. And, a Start Alternate Host Task command has also been added.

A new quick-find tool helps to quickly find items in the strategy tree.

Points can now be created automatically in the Add Module dialog box.

For a complete list of the new features and enhancements in PAC Control, see form 1915, the PAC Project 9.0 Release Notes.

Bug Fixes:

KB80393 Serial I/O units can't be inspected prior to running PAC Control strategy.

KB80370 File > View/Print > Database shows persistent variables as initialize on strategy run.

KB80236 Archived strategies may force download when using different computers

KB55584 Large Int64 table element value partially visible in Debug mode.
PAC Control R8.2g
PAC Project R8.5000
September 4, 2009

New Feature:
PAC Control R8.2g: In support of the new Wired+Wireless devices, you can now configure the number of times a control engine tries to communicate with an I/O unit. Previously, communications timed out after three attempts.

=====================================================================*

PAC Control R8.2f
PAC Project R8.2009
March 20, 2009

New Features:

* For the Generic OptoMMP Device type in PAC Control, added support for the following commands:

  Get I/O Unit Event Message State
  Get I/O Unit Event Message Text
  Set I/O Unit Event Message State
  Set I/O Unit Event Message Text

* For strategies stored on microSD cards, the Autorun flag can be set without storing to flash first.

* Added the following commands. Requires 8.5 firmware.

  IVAL Set Analog Filter Value
  IVAL Set Analog Min Value
  IVAL Set Analog Max Value

* Support has been added for the new SNAP-AIPM-3 module. Requires 8.3 firmware.

Bug Fixes:

KB80469 - Importing a chart with legacy items may cause PAC Control to crash. The fix requires the chart to be exported from version R8.2f or later.

KB80502 - PAC Control's Inspect I/O Unit reports incorrect values for some I/O combinations

=====================================================================*

KB80219 - When background downloading a large strategy and storing it to flash, a timeout may occur. In R8.2b, the timeout value was increased from 30 to 90 seconds. In this version, it's been increased again to 120 seconds.

===================================================================== PAC Control R8.2d
PAC Project R8.2002
August 1, 2008
Bug Fix:

KB80344 - A problem has been corrected where a PAC Control archived strategy stored to the control engine did not survive a power cycle. This is the same issue that was corrected in R7.1e (KB 53999).

===================================================================== PAC Control R8.2c
PAC Project R8.2001
July 10, 2008
Bug Fixes:

KB80296 - A problem has been corrected where a mistic Remote Simple I/O unit could not be moved through a pointer table. When moving such an object from a pointer table into a pointer variable, the controller would report a -29 error (wrong object type).

KB80311 - A problem has been corrected where PAC Control Basic would allow digital output points to have a TPO feature.

===================================================================== PAC Control R8.2b
PAC Project R8.2001
June 25, 2008
Limited release.

Bug Fixes:

KB80108 - A problem has been corrected when importing charts. PAC Control would incorrectly allow the user to select a Windows reserved device name for the new chart name. The reserved names are CON, PRN, AUX, CLOCK$, NUL, COM1 - COM9, and LPT1 - LPT9.

KB80219 - A problem has been corrected where a timeout would occur when doing a background download of a large strategy and storing it to flash.

KB80222 - A problem has been corrected in Action and Condition blocks involving string literals. If an existing command had a string variable as one of its arguments and that was changed to a string literal, PAC Control would crash.

KB80278 - A problem has been corrected when compiling certain OptoScript code that has errors in it. If one line of code had multiple errors, PAC Control might crash when compiling it.
KB80307 - A problem has been corrected where a PID Loop in an OTG file would not import correctly into PAC Control.

KB80310 - A problem has been corrected where selecting an I/O point in the strategy, right-clicking on it, and selecting the "Modify..." menu item could cause unexpected behavior, including crashing PAC Control. This would only happen on PAC I/O units, and only for points located in the upper eight module positions on a rack.

=====================================================================

PAC Control R8.2a
PAC Project R8.2000
June 19, 2008

New Features:

Added the following commands for use with mistic serial I/O units:
- Clear I/O Unit Interrupt
- Disable Interrupt on Event
- Enable Interrupt on Event
- Get Active Interrupt Mask
- Generating Interrupt?
- Interrupt Disabled for Event?
- Interrupt Enabled for Event?

A new report has been added to show information on the location and mappings of I/O points. This can be useful with some commands that use different point mappings, such as "Move I/O Unit to Numeric Table Ex".

Support for mistic ASCII mode has been added. (Pro only)

The following digital point feature types have been added for the SNAP-PAC-R2, EB2, and SB2. The affected commands are also listed.

- On Totalizer
  + Get & Restart On-Time Totalizer
  + Get On-Time Totalizer
  + IVAL Set On-Totalizer
  - Off Totalizer
  + Get & Restart Off-Time Totalizer
  + Get Off-Time Totalizer
  + IVAL Set Off-Totalizer
- TPO
  + Set TPO Period
  + Set TPO Percent
  + IVAL Set TPO Period
  + IVAL Set TPO Percent

The following existing commands have had R2/EB2/SB2 support added:
- Generate N Pulses
- Start Continuous Square Wave
- Start On-Pulse
- Start Off-Pulse
- Get & Clear Analog Totalizer Value
- Get Analog Totalizer Value
- Set Analog Totalizer Rate

Bug Fix:

KB60752 - A problem has been corrected with the command Disable Communication to Point. It would not allow analog points from a G4A8R or B3000 to be used.

Bug Fixes:

KB56685 - A problem has been corrected with subroutines that have numeric literals as parameter types. If called from an Action block and depending upon the exact parameter types and what type was actually being passed to it, the subroutine might exhibit incorrect results, odd behavior, or cause the controller to reset.

KB51029 - A problem has been corrected in Action and Condition blocks related to string literals. If an existing command was being edited that had a string literal, the string literal could not be changed to an empty string.

KB59096 - A problem has been corrected in OptoScript blocks where certain commands were allowed to be used with I/O points that reside on I/O units that do not support the commands. The PAC Control compiler now issues a warning to cover this situation. The affected commands are:

Generate N Pulses
Get & Clear Analog Filtered Value
Get & Clear Analog Totalizer Value
Get Analog Totalizer Value
Set Analog Totalizer Rate
Get Analog Filtered Value
Get Analog Square Root Filtered Value
Get Analog Square Root Value
Start Continuous Square Wave
Start Off-Pulse
Start On-Pulse
Ramp Analog Output

KB54676 - A problem has been corrected in OptoScript blocks where an out-of-range float literal would not cause a compiler error. Also, it would not be possible to download the strategy. Float literals should be in the range of -3.402823e+38 to 3.402823e+38.

KB58312 - A problem has been corrected where instruction blocks could have their names changed in Debug mode by using the F2 shortcut.
Bug Fix:

KB60001 - A problem has been corrected where compiler errors would occur when calling a subroutine from an Action block and passing a variable to a parameter that was configured to accept literals.

PAC Control R8.1a
PAC Project R8.1000
October 8, 2007

New Features:

* Added support for the SNAP-PAC-S2 controller.

* Added support for several new I/O Units:
  SNAP-PAC-SB1
  SNAP-PAC-SB2

* Added support for several new modules:
  SNAP-AICTD-8
  SNAP-AIMA-8
  SNAP-AIV-8

* Added several new commands:
  Flag Lock
  Flag Unlock

* Added Background Strategy Downloads, which is the ability to download a strategy while the current one keeps on running.

* Older Ethernet, Ultimate, and Simple I/O units can be upgraded to their PAC replacements.

Enhancements:

Pointer Tables are now a possible parameter type in the following commands:

  Move Numeric Table to Numeric Table
  Move I/O Unit to Numeric Table
  Move I/O Unit to Numeric Table Ex
  Move Numeric Table to I/O Unit Ex
  Move Numeric Table to I/O Unit
  IVAL Move Numeric Table to I/O Unit
  IVAL Move Numeric Table to I/O Unit Ex

Bug Fixes:

KB59258 - Fixed issues with the following commands. See KB59258 for more detailed information.
KB59467 - A problem has been fixed where OptoScript code that moved an Integer 64 value into a string variable character would cause the strategy to fail when downloading.

=====================================================================

**PAC Control R8.0f**

PAC Project R8.0009
June 29, 2007

**New Features:**

KB56073 - SNAP-PAC-R1 controllers with serial numbers 600,000 and higher now support 4-channel digital modules in slots 8 through 15 as well as in slots 0 through 7. See the KB article for more information.

The following commands have been added:

- Get I/O Unit As Binary Value 64
- Flip Flop JK
- Bit Change

=====================================================================

**PAC Control R8.0e**

PAC Project R8.0007
May 18, 2007

**Bug Fix:**

KB57575 - A problem has been corrected where the Replace tool did not work correctly with OptoScript blocks. When using the Find Next button, it would sometimes highlight wrong pieces of text. When using the Replace All button, it would sometimes replace the wrong pieces of text.

=====================================================================

**PAC Control R8.0d**

PAC Project R8.0006
May, 2007

This version supports the 7.2 firmware for Ultimate and LCE controllers.

**Bug Fix:**
A problem has been corrected where the communication watchdog feature did not work correctly on PAC I/O units. Requires R8.0c firmware for all PAC I/O units.

PAC Control R8.0c
(March 21, 2007):

Bug Fix:

(KB56613) A problem has been corrected with the following commands when used in Action or Condition blocks:
+ Bit Test
+ Bit Off?
+ Bit On?
   (The above commands did not work correctly when the value to test was an Integer 64, SNAP-ENET-D64, SNAP-UP1-D64, SNAP-UP1-M64, or SNAP-ENET-S64.)

+ Read Number from I/O Unit Memory Map
+ Write Number to I/O Unit Memory Map
   (The above commands did not work correctly when the value to read or write was an Integer 64.)

PAC Control R8.0b
(March 5, 2007):

Bug Fix:
(KB56346) A problem has been corrected where strategies created in ioControl 7.1 or 7.0 and then opened in PAC Control 8.0 could not correctly add any of the new modules to an existing SNAP-PAC-R1 or SNAP-PAC-R2 I/O unit.

PAC Control R8.0a
(February 28, 2007):

ioControl has been renamed to PAC Control.

New Features:
-------------

Added support for the following new I/O units:
   SNAP-PAC-EB1
   SNAP-PAC-EB2

Added support for the following existing modules:
   SNAP-IDC-32
   SNAP-ODC-32-SRC
   SNAP-ODC-32-SNK
   SNAP-AITM-8

Added support for the following upcoming modules:
   SNAP-AIMA-32

Added the View I/O Units dialog in the debugger. To access it, double-click on the "I/O Units" folder item.

Added the following commands:
- Set I/O Unit Configured Flag
- Move I/O Unit to Numeric Table
- Move Numeric Table to I/O Unit
- IVAL Move Numeric Table to I/O Unit

Enhancements:
-------------
96 PID loops are now available on the SNAP-PAC-R1, SNAP-PAC-R2, SNAP-PAC-EB1, SNAP-PAC-EB2.

Analog input points on Ethernet brains can now have inverted scaling. (Requires 8.0 PAC controller firmware)

The Configure Variables dialog now has sortable columns.

Debugger Options are now available in the debugger. Use the "Debug -> Options" menu item.

The time it takes to add or rename a variable or I/O object has been improved.

The OptoScript editor now supports the mouse wheel.

Charts and subroutines now support the mouse wheel. The wheel alone will scroll the window vertically. The wheel with the Shift key will scroll the window horizontally.

----------------

PAC Control R7.1e
(October 23, 2006):

New Features:
-------------

Added the following conditions:
- Bit Off in Numeric Table Element?
- Bit On in Numeric Table Element?

Bug Fixes:
----------

* (KB51958) A problem has been resolved where in Action blocks, the "Convert Number to Formatted Hex String" and "Convert Number to String Field" commands did not work properly when an Integer 64 was passed in.
"Convert Number to Formatted Hex String" will work in PAC products, but there is a different bug in the UIO firmware which causes incorrect results regardless of this ioControl bug fix.

* (KB52178) A problem as been resolved where the following OptoScript commands could cause a control engine to reset or have other strange behavior if an Integer 64 was passed to any of the parameters named "Module #", "Point ", "Start Index", "Start Table Index", or "Clear Mask".

 GetHddModuleStates
 GetHddModuleOnLatches
 GetHddModuleOffLatches
 GetClearHddModuleOnLatches
 GetClearHddModuleOffLatches
 GetAllHddModuleStates
 GetAllHddModuleOnLatches
 GetAllHddModuleOffLatches
 GetClearAllHddModuleOnLatches
 GetClearAllHddModuleOffLatches
 ClearHddModuleOnLatches
 ClearHddModuleOffLatches
 SetHddModuleFromMomo
 TurnOnHddModulePoint
 TurnOffHddModulePoint
 GetHddModuleCounters
 GetClearHddModuleCounters
 GetClearHddModuleCounter

* (KB52680) A problem has been fixed where ioControl could crash if all of the following conditions were met:
  + The Configure->Options...->Debugger->"When stepping, make sure the active block is visible" option was set.
  + ioControl was in Debug mode and the loaded strategy was running.
  + The loaded strategy had large charts that were closed.
  + The Find dialog was used to find something.

* (KB52544) A memory leak when using the Find dialog has been fixed.

* (KB53999) A problem has been fixed where an ioControl archived strategy stored to the control engine did not survive a power cycle.

----------------------------

PAC Control R7.1d
(May 4, 2006):

Information in this README file applies to both versions of ioControl unless otherwise indicated with [BAS] or [PRO].

NOTE: See the release notes for the SNAP controller firmware for changes at the firmware level.

Bug Fixes:
--------

* (KB51461) A problem has been fixed where ioControl would become unresponsive after removing a variable from two or more charts and then deleting the
variable. The next time the strategy was saved (either manually or automatically as the result of another user action), ioControl would become unresponsive and have to be terminated manually by the user.

* (KB51393) A problem with exporting charts has been resolved. Items only within OptoScript blocks were sometimes not exported. The behavior would depend upon the exact nature of the chart.

------------------------
**PAC Control R7.1c**
(April 20, 2006) :

Bug Fixes:
--------

[PRO]
* (KB51055) Corrected a problem with inspecting pointer tables that were passed parameters in a subroutine. Opening the inspect dialog would cause a -12 "Invalid table index" error to be put into the control engine's message queue.

* (KB51159) Corrected a problem with inspecting PID loops. When double-clicking on a PID folder in the strategy tree, the I/O unit inspect dialog would incorrectly show the list of points and not the PID loops.

------------------------
**PAC Control R7.1b**
(April 7, 2006) :

Bug Fixes:
--------

[BAS]
* (KB50851) A problem has been fixed where the following commands did not allow counters from the SNAP-PAC-R1 or SNAP-PAC-R2:
  - Clear Counter
  - Get & Clear Counter
  - Start Counter
  - Stop Counter

[PRO]
* (KB50824) Problems with moving a point on a B3000 Analog brain have been corrected. In some situations, ioControl did not allow a point to be moved to all available positions. In other situations, it incorrectly allowed a point to be moved into a module with a different measurement type (e.g. moving a voltage input into a current input).

------------------------
**PAC Control R7.1a**
(March 8, 2006) :

New Features:
-------------
Added support for SNAP-PAC-R1 and SNAP-PAC-R2.

Enhancements:
--------------
* Added the following commands:

Set I/O Unit from MOMO Masks
IVAL Set I/O Unit from MOMO Masks

These commands will work for all I/O units that allow digital points. They replace and deprecate the following commands:

Set Digital I/O Unit from MOMO Masks
Set Digital-64 I/O Unit from MOMO Masks
Set Mixed I/O Unit from MOMO Masks
Set Mixed 64 I/O Unit from MOMO Masks
Set Simple 64 I/O Unit from MOMO Masks
IVAL Set Digital Binary
IVAL Set Digital-64 I/O Unit from MOMO Masks
IVAL Set Mixed I/O Unit from MOMO Masks
IVAL Set Mixed 64 I/O Unit from MOMO Masks
IVAL Set Simple 64 I/O Unit from MOMO Masks

These old commands will continue to work. They have been moved to a new group called "Deprecated".

* The generic names for I/O units have been replaced with the actual part numbers.

<table>
<thead>
<tr>
<th>OLD NAME</th>
<th>NEW NAME</th>
</tr>
</thead>
<tbody>
<tr>
<td>SNAP Mixed Ultimate I/O</td>
<td>SNAP-UP1-ADS</td>
</tr>
<tr>
<td>SNAP Mixed 64 Ultimate I/O</td>
<td>SNAP-UP1-M64</td>
</tr>
<tr>
<td>SNAP Mixed 64 Simple I/O</td>
<td>SNAP-ENET-S64</td>
</tr>
<tr>
<td>SNAP Mixed Ethernet I/O</td>
<td>SNAP-B3000-ENET, SNAP-ENET-RTC</td>
</tr>
<tr>
<td>SNAP D64 Ultimate I/O</td>
<td>SNAP-UP1-D64</td>
</tr>
<tr>
<td>SNAP D64 Ethernet I/O</td>
<td>SNAP-ENET-D64</td>
</tr>
<tr>
<td>B3000 SNAP Digital</td>
<td>B3000 (Digital portion)</td>
</tr>
<tr>
<td>B3000 SNAP Analog</td>
<td>B3000 (Analog portion)</td>
</tr>
<tr>
<td>SNAP Remote Simple Digital</td>
<td>SNAP-BRS</td>
</tr>
<tr>
<td>G4 Digital Multifunction I/O Unit</td>
<td>G4D16R</td>
</tr>
<tr>
<td>G4 Digital Remote Simple I/O Unit</td>
<td>G4D32RS</td>
</tr>
<tr>
<td>G4 Analog Multifunction I/O Unit</td>
<td>G4A8R, G4RAX</td>
</tr>
<tr>
<td>B100 Digital Multifunction I/O Unit</td>
<td>B100</td>
</tr>
<tr>
<td>B200 Analog Multifunction I/O Unit</td>
<td>B200</td>
</tr>
</tbody>
</table>

Bug Fixes:
----------
* (KB49830) A problem has been fixed where in very rare circumstances, ioControl would crash when opening inspect windows in debug mode.

* (KB50224) A problem has been fixed where numeric or string tables that were in a watch window and expanded would cause errors if the table’s name had been changed. This could potentially prevent switching to debug mode.
PAC Control R7.0d  
(January 19, 2006) :

Bug Fixes:
--------

* A problem has been fixed where the Output Maximum Change for any existing PID Loops would change to 0 when opening a pre-7.0 strategy.

* A problem has been fixed where the Replace function would not work correctly if an OptoScript block had lines that ended with just a newline character, not the normal Windows carriage-return and newline pair. This was most likely to happen if OptoScript code was copied from another program, like an email client.

* A problem has been fixed where a chart was not marked as being modified and needing to be compiled when using the Replace function and changes to the chart only occurred in OptoScript blocks.

PAC Control R7.0c  
(January 1, 2006) :

Bug Fixes:
--------

[PRO] (KB49424) The "Set Analog Load Cell Fast Settle Level" and "Set Analog Load Cell Filter Weight" commands change to the "Set All Target Address States" and "Get Target Address State" commands, respectively, when OK is clicked from the Add Instruction dialog window. Also, the code will not compile.

PAC Control R7.0b  
(January 22, 2005) :

Bug Fixes:
--------

[PRO] ioControl would crash when opening an OptoControl strategy that called a subroutine.

When exporting I/O units, it was possible that the incorrect IP address would be written to the OTG file. This was most likely to happen after previously importing the configuration from an ioManager-generated OTG file.

PAC Control R7.0a  
(December 19, 2005):

New Features:
[PRO] Added the ability to import OptoControl strategies.

[PRO] Added support for serial mistic brains.

[PRO] Added secondary target addresses for Ethernet-based I/O units.

[PRO] Added I/O units, digital points, analog points, and pointer tables as possible passed-parameter types for subroutines. Pointer variables were added as a possible local variable type for subroutines.

Added support for the following modules (see also R6.1c):
- SNAP-AIARMS-i
- SNAP-AIVRMS-i

Enhancements:

Added an option to control if the active block is always visible when stepping through a chart. The behavior was changed in R5.1a. This option lets you choose old or new behavior. The option is under Configure -> Options -> Debugger.

When exporting a chart or copying blocks, items only within OptoScript blocks are now included.

Bug Fixes:

When entering debug mode, existing breakpoints in the control engine were not being displayed in ioControl.

(KB1428) - When inspecting an action block while in Online mode, the AND/OR operators would incorrectly appear as an option within the window. These operators are only for a Condition block.

(KB48089) - In the Edit PID Loop dialog, the range checking for forced output values was incorrect.

(KB47922) - In commands, ioControl would allow the user to enter an integer literal that was out of range. A -13 overflow error would occur when the strategy was downloaded to a controller.

Invalid numeric literals could be entered in the Add Instruction dialog.

ioControl would crash if an ActiveX control was not loaded. The dialogs affected are View PID Loop and Inspect Table, both in the debugger.

When stepping through OptoScript blocks with 'case' statements, the 'break' keyword had incorrect line information.
PAC Control R6.1c
(July 28, 2005):

New Features:
------------

Added support for the following modules:
   SNAP-AOA-23-i
   SNAP-AIMA2-i modules.
   SNAP-AILC module.

Added the following commands:
   Set Analog Load Cell Fast Settle Level
   Set Analog Load Cell Filter Level

Enhancements:
------------

UIO now supports up to 32 PID loops.

PAC Control R6.1a
(February 14, 2005):

New Features:
------------

Added support for new HDD modules.

Bill of Materials tool.

Added the following commands:
   Get HDD Module States
   Get HDD Module On-Latches
   Get HDD Module Off-Latches
   Get & Clear HDD Module On-Latches
   Get & Clear HDD Module Off-Latches
   Get All HDD Module States
   Get All HDD Module On-Latches
   Get All HDD Module Off-Latches
   Get & Clear All HDD Module On-Latches
   Get & Clear All HDD Module Off-Latches
   Clear HDD Module On-Latches
   Clear HDD Module Off-Latches
   Get HDD Module Counters
   Get & Clear HDD Module Counters
   Get & Clear HDD Module Counter
Set HDD Module from MOMO Masks
Turn On HDD Module Point
Turn Off HDD Module Point

Enhancements:
--------------

Bug Fixes:
----------

In the ioControl debugger, when changing the value of a string variable or string table element, strange behavior could happen if another application (such as ioDisplay) was also communicating with the control engine's host port.

The following OptoScript for/next loop would execute once, when it should not have looped at all. This would result with x being 1 when it should be 0.

```
x = 0;
for n = 0 to -1 step 1
    x = x + 1;
next
```

-----------------------------

PAC Control R6.0b:

Bug Fixes:
----------

In the debugger, if an analog point's XVAL was out of range, it was not possible to change the IVAL. You would get an error that the XVAL was not valid. This bug was introduced in version 5.0.

In the debugger, in binary view mode, it was not possible to change the bits of an integer 64 variable.

When adding or editing analog temperature points, the dialog showed their units as being Celsius, even if the I/O unit was set Fahrenheit. This was a display problem and did not affect the compiler or debugger.

When copying a block from a chart into a subroutine, it was possible to copy types that are not allowed in subroutines. This included pointer variables, pointer tables, and PID loops. This would cause various types of strange behavior, including items showing up at the top of the strategy tree and problems when running the strategy on a device. ioControl will now check for this when pasting blocks into a subroutine. I/O units, points and charts were already being checked.

The following commands did not allow points which were on a Mixed 64 I/O unit:
  Calculate & Set Analog Gain

Calculate & Set Analog Offset
Get & Clear Analog Maximum Value
Get & Clear Analog Minimum Value
Get Analog Maximum Value
Get Analog Minimum Value
IVAL Set Analog Point
Set Analog Filter Weight
Set Analog Gain
Set Analog Offset
Set Analog TPO Period

-----------------------------
PAC Control R6.0a
(October 1, 2004):

New Features:
-------------
Added subroutines to allow greater flexibility in building flowcharts.

Added the following commands:
   Set Analog Filter Weight
   Float Valid?
   Get Available File Space

Enhancements:
-------------
I/O units may now share an IP address if their ports are different.

Bug Fixes:
----------
Digital points in slot #63 with the watchdog turned on no longer cause an
overflow error when downloading the strategy.

Using timers with mathematical and comparison commands now reliably returns
accurate results. Some mathematical and comparison results were sometimes
inaccurate when used in Action and Condition blocks with commands such as
Add, Subtract, Divide, Multiply, Maximum, Minimum, Equal?, Greater Than or
Equal?, Greater?, Less?, Less Than or Equal?, Not Equal?.

I/O unit watchdog timeout values are now sent to I/O units only when
configured to do so.

ioControl no longer negatively affects mouse behavior in other running
applications, as it sometimes did previously. The effect was noticed with a
two-wheel mouse, but could have caused other problems, too.

A PID loop with a setpoint type coming from another PID's output is now
correctly compiled.

ioControl no longer tends to lock up while inspecting PID loops with
unplugged input points. A new version of the iPlotLibrary.ocx plot control fixed the problem.

The "Command Help" button in an OptoScript dialog box will now reliably bring up the Command Reference Help, even if the command is completely highlighted.

The I/O Unit Inspect dialog now correctly displays all bits from the last letter in the version. For instance, an Ethernet I/O unit with a R3.0q kernel was displayed as "R3.0a".

The following commands now compile correctly when using D64-type brains as a parameter.

Read Number from I/O Unit Memory Map
Write Number to I/O Unit Memory Map
Numeric Table Element Bit Test
Get I/O Unit as Binary Value
Bit Clear
Bit Rotate
Bit Set
Bit Test
Bit On?
Bit Off?

The IVAL Set Analog Point command now compiles correctly when an integer is used as the source value.

Using the AddMessageToQueue command in an OptoScript block no longer causes a download error.

-------------------------------
PAC Control R5.1b
(February 11, 2004):

Bug Fixes:
---------

It was not possible to add PID loops to Ethernet I/O units created in pre-5.1 versions of ioControl. This version will both fix and prevent the problem.

A bug fix in R5.1a regarding 'for' loops with a negative step was not correct.

The command "Convert Number to Hex String" didn't work correctly for Integer 64s.

-------------------------------
PAC Control R5.1a
(December 1, 2003):

New Features:
------------
PID loops

Added support for the SNAP-ENET-S64 product, known in ioControl as SNAP Mixed 64 Simple I/O.

Added the following commands:

  Copy Current Error to String
  Add Message to Queue
  Get Severity of Current Error

Get PID Input
Get PID Current Input
Get PID Setpoint
Get PID Current Setpoint
Get PID Feed Forward
Get PID Output
Get PID Gain
Get PID Tune Integral
Get PID Tune Derivative
Get PID Feed Forward Gain
Get PID Max Output Change
Get PID Min Output Change
Get PID Input Low Range
Get PID Input High Range
Get PID Output Low Clamp
Get PID Output High Clamp
Get PID Scan Time
Get PID Forced Output When Input Under Range
Get PID Forced Output When Input Over Range
Get PID Mode
Get PID Configuration Flags
Get PID Status Flags

Set PID Input
Set PID Setpoint
Set PID Feed Forward
Set PID Output
Set PID Gain
Set PID Tune Integral
Set PID Tune Derivative
Set PID Feed Forward Gain
Set PID Max Output Change
Set PID Min Output Change
Set PID Input Low Range
Set PID Input High Range
Set PID Output Low Clamp
Set PID Output High Clamp
Set PID Scan Time
Set PID Forced Output When Input Under Range
Set PID Forced Output When Input Over Range
Set PID Mode
Set PID Configuration Flags

Disable Communication to PID Loop
Enable Communication to PID Loop
PID Loop Communication Enabled?

Set Simple 64 I/O Unit from MOMO Masks
IVAL Set Simple 64 I/O Unit from MOMO Masks

Enhancements:
-------------

Info and warning messages have been added to the error queue.

The Add Module dialog has been improved.

Dialogs in the Configurator now know if a change has actually been made when the OK button is used to close the dialog. This should help prevent many cases of inadvertently making a change that would then require a download before entering Debug mode.

In the debugger, the "Step Line" and "Step Block" buttons have been replaced with "Step In", "Step Over", and "Step Out" buttons.

The "Command Help" button in the OptoScript dialog is now smarter.

Keyboard and mouse standard shortcuts were added:
   When a block is selected, the F2 key brings up the Name Block dialog.
   When a flowchart window is selected, holding the CTRL key while scrolling the mouse wheel will change the zoom setting.

While stepping through a chart, if the active step block is not visible, it will be scrolled into view.

Added the ability to clamp analog output points.

When archiving a strategy to a control engine and then uploading the archive back to a PC with ioTerm, you can now go directly into debug mode without downloading.

Resolved several issues with idle session timeouts.

Bug Fixes:
----------

In a flowchart, making multiple object selections with the Shift key was not working.

Some combo boxes in the Find and Replace dialogs were not wide enough to show all of their content.

For SNAP-AOA-23 and SNAP-AOV-25 modules, the "Custom..." scaling button was incorrectly enabled in the Edit Analog Point dialog.

Communication Handles were not being created when Action and/or
Condition blocks were pasted between strategies.

In watch windows, pointer variables were not displaying properly.

When opening a chart window, it was possible that it would be placed outside of the viewable area.

String Tables with long initialization strings could cause download errors.

String Tables using the "Initialize on strategy download" option were not being initialized correctly.

In OptoScript blocks, some float literals were being truncated when compiled. For instance, 5.335004e-7 was being truncated to 0.000001.

In OptoScript blocks, 'for' loops with a negative step did not work properly. They did one less iteration than they should.

Adding I/O points on-the-fly would not work if a type-mismatch occurred.

---

**PAC Control R5.0a**

(August 1, 2003):

**New Features:**

---

Added support for the SNAP-UP1-M64 product, known in ioControl as SNAP Mixed 64 Ultimate I/O.

Two new communication handle drivers: "file" and "ftp".

Added the following command(s):

- Get Type From Name
- Get Value From Name
- Send Communication Handle Command
- Transfer N Characters
- Convert IP Address String to Integer 32
- Convert Integer 32 to IP Address String
- Erase Files in Permanent Storage
- Save Files To Permanent Storage
- Load Files From Permanent Storage
- Set Mixed 64 I/O Unit from MOMO Masks
- IVAL Set Mixed 64 I/O Unit from MOMO Masks

**Bug Fixes:**

---


27
In some situations, unnecessary downloads were being required when changing to debug mode. To reproduce:
1. Download a strategy
2. Go to Config mode
3. Change a chart (like adding an empty block)
4. Go to Debug mode. It will do a normal download
5. Go to Config mode
6. Close the strategy
7. Open the strategy
8. Go to Debug mode. It will require a download, even though it shouldn't.

-----------------------------
**PAC Control R1.0d**
(April 4, 2003):

**Bug Fixes:**

---

Duplicate variables could be created in the strategy database when removing a variable from two or more charts and then deleting the variable.

-----------------------------
**PAC Control R1.0c**
(August 15, 2002):

**New Features:**

---

Added the following command(s):
- Get End-Of-Message Terminator
- Set End-Of-Message Terminator
- Clear Communication Receive Buffer
- Compare Strings
- Move to Numeric Table Elements
- Move to String Table Elements

Added the ability to make a "control engine download file". This makes it easy to download a compiled strategy for a specific control engine using ioTerm.

**Enhancements:**

---

Object selection and interaction using the mouse is now much closer to Windows standards.

In the debugger, controller busy errors will now be retried several times before posting a message.

In the debugger, the error field in the status bar is now highlighted red and will display the Inspect Controller dialog when clicked.

An "A_" is no longer prepended to the beginning of a name when naming an object. The name will be checked either when the focus has changed or the dialog is closed.
When adding an I/O unit, Ultimate I/O is now the default, not Ethernet I/O.

The time it takes to record a variable or I/O name change has been decreased in large strategies that have charts without OptoScript blocks.

The time it takes to initialize a table has been greatly improved.

Bug Fixes:
----------

Pointer variables using the "Initialize on strategy download" option were not being properly initialized.

In strategies that have OptoScript blocks, the Find and Replace dialogs were occasionally having problems and showing the "Could not open OptoScriptTemp.txt for the OptoScript compiler" error message.

OptoScript blocks with unterminated comment blocks (i.e. /* and */ ) would cause the OptoScript lexical analyzer to enter an incorrect state, causing unexpected behavior.

When moving an I/O point referenced in an OptoScript block to a different location, the reference count for the item would become incorrect.

The debugger's string table inspect dialog was not properly displaying tables that were wider than 127 characters.

Focusing issues in the "Add Instruction" dialog have been addressed.

The Find and Replace dialogs were not finding instances of communication handles in OptoScript blocks.

When using the Replace All button in the Replace dialog to replace items in OptoScript blocks, neither the old or new items would have their reference counts updated.

-------------------

PAC Control R1.0b
(November 21, 2001):

New Features:
------------

Added an "Inspect Communication Variable" dialog for inspecting communication handles in the debugger.

Added a "Command Help" button to the OptoScript editor dialog.
Added a "Strategy Information" menu item for displaying the open strategy's file name and path.

Added the following commands:
- Receive String Table
- Receive Pointer Table
- Transmit String Table
- Transmit Pointer Table
- Get Pointer From Name

Enhancements:
-------------

The "Inspect Control Engine" dialog has been improved. The "Persistent RAM" and "Revision Time" fields are new.

The "Inspect Control Engine" dialog now uses a different method for determining the communications loop time. It now displays the time taken for one single transaction, rather than several.

The "Move Numeric Table to Numeric Table" command now checks for valid table lengths and indexes.

Automatically saving a strategy to flash memory after making an online change has been enabled.

The commands "Receive Numeric Table" and "Transmit Numeric Table" now support Integer 64 Tables.

Bug Fixes:
----------

* The "Move To" feature in the "Configure I/O Points" dialog was incorrectly allowing points to be moved to the wrong location.

* The "Select Continue Block Destination" dialog was not showing OptoScript blocks.

* Syntax errors in OptoScript code involving a table would not display the correct error line number.

* String assignments in OptoScript would not work correctly if the same item was on both sides of the assignment operator.

* It was possible to copy or import a chart with a name that already existed in the strategy database.

* Importing charts with I/O units in them could lead to multiple I/O units having the same address. An added I/O unit will now have an initial IP address of 0.0.0.0.

* When importing charts or copying block, I/O points that needed to be added were not being added in the proper location.

* When importing charts, integer 64 variables and tables were not being matched correctly.
* In the debugger, setting a string variable or table element to be empty would cause the control engine to lock up.

* Any OptoScript or Instruction dialogs opened because of line stepping were not being automatically closed when leaving the debugger.

* The command "Get Nth Character" was returning a -42 error for a string with non-printable characters even though the index was valid.

* The command "Convert IEEE Hex String to Number" was not always returning the correct value. For example, the manual uses the example of 418E666 converting to 17.8, but the command was returning 18 instead.

Uninstallation of this Product:
-------------------------------

A utility is provided to uninstall this product. The utility will remove all registry entries and files previously installed.

Exceptions to this are:
- Previously configured control engines are not removed from the registry.
- The installation directory tree is not removed if any user-created files exist in it.
- The program folder or group is not removed if any icons have been added by the user.

PAC Redundancy Manager
PAC Redundancy Manager R9.0b
PAC Project R9.0003
July 22, 2010

Bug Fix:
--------

KB81026 'Incorrect device type' incorrectly reported by PAC Redundancy Manager.
Enhancements:

* You can now add a control engine-driven dynamic attribute to text on a button.

* The new AutoCorrect Tags option on the Configurator Options dialog box allows AutoCorrect Tags to either include or exclude tags inside grouped graphics. By default tags inside grouped objects are excluded. Since dynamic attributes inside a grouped object are not used, if they are included you may receive irrelevant errors when AutoCorrect Tags is run. However, you can choose to include them if you wish.

* The Window Properties dialog box now has a new option to rescale the window graphics when the window size is changed in that dialog box.

* The new Change Font and Multiply Runtime Height By... configuration options allow you to change the font or spacing of text items listed in a combo box.

* A new option on the Runtime Setup dialog allows you to choose which PC to use to sync the control engine's clock.

* State changes in alarm points and fill or line color dynamic attributes are modified in name and behavior. These state changes are now affected by a Hysteresis value rather than a Deadband value. The hysteresis value is applied when the state goes toward normal; when going away from normal, the state changes immediately.

Bug Fixes:

Configurator (Basic and Pro)

KB81316 'Out of service' errors reported in PAC Display.

KB81592 Upgrading a PAC Display project from 8.2 to 9.1d when it has an XY plot caused crash.

KB81693 New duplicated alarm point incorrectly had identical links and attributes as the original point.

KB81727 Could not Cancel from importing a window into PAC Display.

KB81853 Alarms in PAC Display did not trigger at the expected alarm limits. (Incorrect implementation of deadband; the more correct implementation, hysteresis, is now implemented.)
KB81729 PAC Display Runtime could not connect to remote OptoOPCServer under Windows7 and Vista.

KB81743 'Display message box for new alarm points' option sometimes caused problems in Runtime.

KB81801 Combobox control did not perform Send dynamic attributes if only output dynamic attributes were configured.

KB81883 Historic Logs were not logging Integer64 values.

KB81877 Instead of logging data in a trigger-based Historic Data Log every time a trigger occurs, data was logged based on the Refresh Time configured in the Historic Log Configuration.

KB81878 When configured to log only one sample, trigger-based Historic Log Point data was recorded twice instead of only once.

==============================================================================
PAC Display Professional R9.1d
PAC Display Basic R9.1d
PAC Project R9.1003
October 14, 2011

Bug Fixes:

Configurator (Basic and Pro)
=================================
KB81438 AutoCorrect Tags does not update tags in Combo Boxes.

FAC2PAC Conversion Utility
=================================
KB81512 OptoDisplay to PAC Display conversion utility does not correctly update alarm graphics.

Enhancement:

Runtime (Basic and Pro)
=================================
A button has been added to Event Log to save Event Log data.

==============================================================================
PAC Display Professional R9.1c
PAC Display Basic R9.1c
PAC Project R9.1002
September 16, 2011

Bug Fixes:

Runtime (Basic and Pro)
=================================
KB81393 Modified default SuperTrend pen plots are not drawn correctly.

Configurator and Runtime (Basic and Pro)
KB81382  PAC Display prints only once.

Enhancement:

FAC2PAC (OptoDisplay to PAC Display conversion utility)  
-------
A new dialog alerts the user that the conversion process requires that all controllers in an OptoDisplay project must be configured as Ethernet controllers prior to conversion to PAC Display. The OptoDisplay controller itself does not need to be an Ethernet controller, but it must be re-configured as Ethernet in the OptoDisplay project in order for the conversion to succeed.

PAC Display Professional R9.1b  
PAC Display Basic R9.1b  
PAC Project R9.1001  
August 17, 2011

Bug Fixes:

Configurator (Basic & Pro)  
-------------------------------
KB81363  Cannot paste or duplicate objects in PAC Display Configurator.

KB81389  PAC Display hangs when attempting to convert OptoDisplay project.

Configurator and Runtime (Basic and Pro)  
------------------------------------------
KB81365  Fourth table in Table object appears cut off.

Runtime (Basic and Pro)  
----------------------
KB81379  Scratch Pad Float Table values not displayed in Table object.

PAC Display Professional R9.1a  
PAC Display Basic R9.1a  
PAC Project R9.1000  
July 18, 2011

Configurator (Basic and Pro)  
-------------------------------
Enhancements:

- A Clear Send Dialog Input Fields option has been added to the Security tab of the Runtime dialog box. When selected, previous Send Value and Send String values on subsequent appearances of the Send Value and Send String dialog boxes are not shown.

- The Tools > AutoCorrect Tags command now searches tags within grouped graphic objects.

- Table column widths are now saved and restored in Configurator and Runtime.
• Move Up and Move Down buttons have been added to the ComboBox Dynamic Attribute dialog that move an item up or down in the list.

• OptoDisplay Converter now converts an OptoDisplay project to the current version of PAC Display. Previously the project was converted to an earlier version.

Bug Fixes:

KB81110 PAC Display Configurator requests tag for Controller Status Alarm Point.

KB81263 PAC Display - Setting the Execute Menu Item not working correctly.

KB81192 Edit > Replace command does not make changes within a ComboBox in PAC Display.

KB81193 Problems resizing a polygon after rotating it.

KB81196 Regenerate Scanner Tags command skips tags in ComboBox control.

KB81218 PID State for Auto and Manual Modes are incorrect via the controller.

KB81264 Bit indices past 31 in Int64 table element are not changed by Edit > Replace.

KB81278 Cannot select SuperTrend log file format.

KB81265 ComboBox element change is not saved.

KB81316 'Out of service' errors reported in PAC Display.

KB81323 Copying and pasting a bitmap results in a blank image or crash.

KB81329 Edit > Replace, Refresh Group does not work for SuperTrends.

KB81330 PAC Display Configurator: Importing AlarmPoints caused extra characters in Alarm Point List Box under Windows XP.

KB81331 View > Dynamic Attributes displays the incorrect SuperTrend Refresh Group.

KB81332 Importing a Window with GIF graphics crashes Configurator.

Runtime (Basic and Pro)

========================

Enhancements:

If an alarm point has persistence configured and it goes into and out of alarm state before the persistence time expires, Runtime no longer logs the return to Normal state.

Bug Fixes:
KB81095  PAC Display Runtime may hang if Alarm Point tags are disabled.

KB81099  Memory leak in PAC Display Runtime if logging String Tables in Historic Logs.

KB81109  PAC Display Historical SuperTrends do not correctly plot logarithmic Data.

KB81183  Opening an 'always in memory' window that contains a .GIF file will cause PAC Display Runtime to crash.

KB81216  PAC Display crashes when a button is configured with multiple dynamic attributes and one of the attributes is set to exit PAC Display Runtime.

KB81256  Logarithmic SuperTrends with pen Minimum scaled <0.01 may cause Runtime problems.

KB81266  Triggered historic log has mostly commas as data.

KB81271  Discrete write to Analog/Digital I/O Unit in Runtime causes error messages.

KB81298  Printing a window at Runtime includes Print dialog box.

KB81325  Printing at Runtime produces twice as many Copies.

Runtime (Basic)

Bug Fix:

KB81346  PAC Display does not switch back to Primary Controller from Backup Controller.

=====================================================================

PAC Display Professional R9.0f
PAC Display Basic R9.0f
PAC Project R9.0006
September 17, 2010

Bug Fix  (Configurator Basic and Pro)

KB81080  PAC Display's 'Edit > Replace' does not replace table names in table objects.

=====================================================================

PAC Display Professional R9.0e
PAC Display Basic R9.0e
PAC Project R9.0005
August 23, 2010

Bug Fix  (Configurator Basic)

KB81062  Graphics and windows problems in PAC Display R9.0d.
New Features for Configurator and Runtime

* GIF images may be imported.

* Hint text may be added to the Tooltips box of a basic graphic such as a line, rectangle, ellipse, or text. The Tooltips box is displayed when the mouse is hovered over the graphic in Runtime.

* When configuring floating point tables using the table control, you can specify the number of decimals for floating point tables.

* The Windows button control allows configuring the Visibility/Blink Control Engine Drive Dynamic Attribute.

Enhancement for Configurator

If multiple alarm points are exported to one .ADL file, all alarm points can be re-imported. Prior to this version, only the first alarm point was imported.

Bug Fixes for Configurator Basic and Pro

KB81042 BIT suffix added to non-integer variable when using Edit > Replace, 'Bit index' Offset command.

Bug Fixes for Runtime Basic and Pro

KB81023 Real-time SuperTrend data plots may not be updated.

KB81037 Some Historic Log files may have incorrect data in projects with more than 21 files

KB81039 Multiple Send (Value, Discrete, String) attributes are not all processed if Windows attribute is also configured.

PAC Display Professional R9.0c
PAC Display Basic R9.0c
PAC Project R9.0002
July 8, 2010

New Feature (Configurator Basic and Pro)

Added a reverse-diagonal (\) graphic fill style

Bug Fixes

Configurator (Basic and Pro)

KB80972 Negative Decimal Values between 0 and -1.0 not allowed for some Control Engine Driven Dynamic Attributes.
KB81021 Problems with PAC Display Configurator when resizing Alarm Point dialog.

Runtime (Basic and Pro)
========================

KB81009 ComboBox may cause unexpected results in PAC Display Runtime.

KB81012 PAC Display Runtime Historic Log does not log String Tables correctly.

KB81013 Possible problems with PAC Display tables using the Relative Offsets option.

KB81020 Random problems with PAC Display Runtime.

Runtime (Pro Only)
==================

KB81010 Possible unexpected results when closing PAC Display Runtime if PIDViewer Open.

KB81014 PAC Display Runtime PIDViewer may cause Floating Point Exception.

Runtime (Basic Only)
====================

KB81019 Long delay when starting PAC Display Basic Runtime.

===================================================================== PAC Display Professional R9.0b PAC Display Basic R9.0b PAC Project R9.0001 June 22, 2010

Bug Fixes

Configurator (Pro)
==================

KB80995: PID Input scale not displayed as expected in PIDViewer.

KB80999: PAC Display PID Button Configuration Doesn't Allow Setpoint Min of 0.0.

Configurator (Basic and Pro)
============================

KB80989: Incomplete Combo Box setup may cause problems in PAC Display Configurator.

===================================================================== PAC Display Professional R9.0a PAC Display Basic R9.0a PAC Project R9.0000

June 15, 2010

New Features

For a complete list of the new features in PAC Display, see form 1915, the PAC Project 9.0 Release Notes.

Enhancements

Configurator and Runtime (Basic and Pro)
=======================================

Table column resizing enhancement has been removed because Runtime performs better without it.

Configurator (Basic and Pro)
============================

If SymbolFactory doesn't exist in the location specified by the registry entry, a search now looks for the SymbolFactory subfolder in the PAC Display directory.

Runtime (Basic and Pro)
=======================

Global operator logins and logouts are now logged in the Runtime Operator log file that is configured from Configure > Runtime in Configurator.

Bug Fixes

Runtime (Pro)
-------------

KB80947: PAC Display Pro reports error at Runtime if string tables in FactoryFloor strategy are used.

Runtime (Basic and Pro)
-----------------------

KB80772: Not all SuperTrend pens may be plotted at Runtime if one pen's value is -NAN.

KB80761: Improved PAC Display Runtime User Log-in.

KB80724: Alarm state keeps occurring even after ACK in Runtime.

KB80692: The focus frame around a text graphic disappears at Runtime if the send string is empty.

KB80707: SuperTrend Y-axis labels < 1 are incorrectly displayed.

KB80677: PAC Display Tables do not display Scratch Pad Strings.

KB80673: Adjustable alarm points not logged correctly in Runtime Operator Log File.

KB80672: Historic Logs using Start Triggers do not initially log data.
KB80740: Edit > Replace, Table Index 'Offset By' option causes non-table tags to appear as tables.

KB80739: PAC Display Configurator View->Find Tag may not find some tags.

KB80877: Multiple clock synchronizations may cause Runtime problems.

Bug Fixes

KB80642: Rotate attribute for line object and integer tag causes problems at Runtime

KB80663: Visibility/Blink does not work correctly for bitmap graphics

Bug Fixes

KB80642: Cannot Delete Table from Table Object

KB80593: View-Dyanamic Attributes may cause PAC Display to crash

KB80600: Windows dynamic attributes aren't always displayed in PAC Display Configurator

Enhancement

On the Configure Table dialog box, there is now a button labeled X that deletes the configured table. This was added to resolve the problem described in KB80591.

KB80591: Cannot Delete Table from Table Object

KB80593: View-Dyanamic Attributes may cause PAC Display to crash

KB80600: Windows dynamic attributes aren't always displayed in PAC Display Configurator
KB80590: Some recipes don't upload when several are triggered at nearly the same time

KB80598: PAC Display Runtime possibly unresponsive on exit if there are many alarms

KB80616: HiHi alarms sometimes cannot be acknowledged in the Runtime alarm window

=====================================================================
PAC Display Professional R8.2k
PAC Display Basic R8.2k
PAC Project R8.2011
June 2, 2009

Configurator (Basic and Pro)
===========================

KB80578: PAC Display project migrated from OptoDisplay or ioDisplay may crash at Runtime due to obscure problem.

KB80580: Some non-integer cutoff values and limits may not be evaluated correctly in PAC Display. (Note that this bug was introduced in R8.2J, but has been fixed in R8.2K.)

Runtime (Basic and Pro)
========================

KB80556: Save Project and Load Runtime may fail when Runtime is already running.

KB80578: PAC Display project migrated from OptoDisplay or ioDisplay may crash at Runtime due to obscure problem.

=====================================================================
PAC Display Professional R8.2j
PAC Display Basic R8.2j
PAC Project R8.2010
May 1, 2009

Runtime (Basic and Pro)
========================

KB80555: Integer values >16,777,215 may cause inaccurate fill color in PAC Display.

KB80568: On-screen keyboard isn't displayed when editing tables.

=====================================================================
PAC Display Professional R8.2i
PAC Display Basic R8.2i
PAC Project R8.2009
March 25, 2009

This version corrects an inadvertent dll dependency introduced in R8.2h.

Configurator (Basic and Pro)
KB80537: Can't change from SuperTrend Pen Discrete Deadband in PAC Display Configurator

Enhancement

When a user sets or modifies the project-wide password, a message warns that if the password is lost, the project cannot be opened in Configurator.

Runtime (Basic only)

The following problem has been fixed:

KB80536: Runtime text data may be incorrect if window has non-consecutive refresh groups

Runtime (Basic and Pro)

The following problem has been fixed:

KB80551: On-screen keyboard missing at Runtime

===================================================================== PAC Display Professional R8.2h PAC Display Basic R8.2h PAC Project R8.2008 March 20, 2009

This version contained an inadvertent dll dependency. Do not use this version. Use R8.2i instead.

===================================================================== PAC Display Professional R8.2g PAC Display Basic R8.2g PAC Project R8.2007 February 13, 2009

Configurator (Basic and Pro)

The following problems have been fixed:

KB80481: Graphics with Alarm Point dynamic attribute may display incorrect alarm state

KB80482: Table editing remains active in PAC Display Runtime

KB80496: SuperTrend Pen Discrete and Value Deadband logging always enabled

KB80500: PAC Display Runtime may hang on exit

Runtime (Pro only)

=====================================================================
KB80501: Missing parameters from PAC Display Runtime's Current Device Config window for FactoryFloor Ethernet controllers

PAC Display Professional R8.2f
PAC Display Basic R8.2f
PAC Project R8.2006
December 5, 2008

Configurator (Basic and Pro)

The following problems have been fixed:

KB80423: PAC Display crashes if Scale Window tool is selected and cursor is clicked inside window

KB80441: Regenerate IO Scanner Tag Names skips the Append String tag for Launch Application dynamic attribute

Runtime (Basic and Pro)

Enhancement

PAC Display now downloads recipes up to 10 times faster.

Bug Fixes

The following problems have been fixed:

KB80439: PAC Display may crash on exit

KB80440: Obscured graphics in PAC Display Runtime

KB80443: Narrow XY Plots drawn incorrectly

KB80463: Control engine synchronization to PC time runs continuously nearing December 31st

KB80467: Runtime crashes if graphic is clicked before its window closes

PAC Display Professional R8.2e
PAC Display Basic R8.2e
PAC Project R8.2004
October 3, 2008

Configurator (Basic and Pro)

The following problems have been fixed:

KB80403: When a PAC Display project contained a large number of SuperTrends (approx. 50+), Runtime version 8.2 was less responsive than Runtime version 8.1.
Configurator (Basic and Pro)

The following problems have been fixed:

**KB80360**: PAC Display Configurator was generating Float Table bit index tags for projects that had been upgraded from Mistic MMI or early versions of OptoDisplay.

**KB80361**: The Save Metafile As... command would randomly fail for metafiles that had been imported into PAC Display.

**KB80362**: The PID Process Variable tag failed to generate an OPC Item name in projects that had been upgraded from Mistic MMI or an early version of OptoDisplay.

**KB80389**: When selecting objects on a screen, and using the Edit > Replace function, the Find and Replace window opens. When you clicked on the Chosen Graphics Radio button, it actually selected the All Windows radio button.

**KB80390**: If polyline, polyshape, or polygon graphics had their points modified by commands such as Flip or Rotate, then the Undo would not work correctly, and would display no graphic. Any subsequent modification to this graphic would cause Configurator to crash.

Runtime (Basic and Pro)

The following problems have been fixed:

**KB80225**: Security User/Group login does not work as expected in PAC Display Runtime

**KB80176**: If a SuperTrend is configured with Disabled Scanning set to when the window is closed, minimized, or both, and the window containing the SuperTrend was initially open when Runtime started, the SuperTrend would not update.

**KB80368**: The Send Value and Send Discrete commands could not successfully send data to PID tags that originated from Mistic MMI or OptoDisplay projects. Attempts to send data at Runtime displays a message similar to the following in the Event Log Viewer:

`TValue() Error: Referenced Type: <type> Actual Type: <type>`

The wording for <type> depended on the type of tag written to (integer, float, etc.).

**KB80382**: Security for Local PC accounts was not fully working. If security was configured for an Operator Driven Dynamic Attribute, and the PC was not on a domain, Runtime would not allow granted users to perform the operation.
PAC Display Professional R8.2c  
PAC Display Basic R8.2c  
PAC Project R8.2002  
August 1, 2008

Note: Configurator R8.2c was an internal release only.

Bug Fixes  
Runtime (Basic and Pro)

The following problems have been fixed:

KB80332: Projects containing Trends sometimes crashed when the Trend added data points after the Trend was full.

KB80345: If a window had a graphic with either the Window, Upload Recipe or Download Recipe Operator Driven Dynamic Attribute and no tags in the window belonged in Refresh Group 0, then the tags were not added to the OPCServer.

KB80346: Trying to read a binary SuperTrend historic log would sometimes cause the PC to hang when the end of the file was reached.

KB80347: If an alarm point was configured to play a sound when alarmed, and the point had a persistence time, once the persistence time expired, if the point was still in alarm, the sound did not play.

KB80352: If a table entry was being edited in Runtime, negative numbers were not being accepted as valid integers or floating point values.

PAC Display Professional R8.2b  
PAC Display Basic R8.2b  
PAC Project R8.2001  
July 11, 2008

Enhancement  
Configurator (Basic and Pro)

* Redesigned the use of the new PAC Display 8.2 registry locations to accommodate users without administrative privileges who use Configurator.

* When saving a project, or using the Tools->Regenerate IO Scanner Tags command, if a tag error occurs, the operation will fail rather than continuing to process each tag.

Bug Fixes  
Runtime (Basic and Pro)

The following problems have been fixed:

KB80318: PAC Display 8.2a accidentally altered bit toggling behavior so that bits could only be toggled one time.

KB80319: After editing a cell in the Table control, if a user pressed the Tab key, or one of the arrow keys, Runtime would hang or crash.
New Features

Configurator (Basic and Pro)

- In the Find and Replace dialog box, you can now use a table or bit index offset to select one or several graphics and change the index easily.
- Enhanced log-in features:
  - The user permissions information may now be saved to a global location and a backup location, so that other Pac Display Configurator nodes can read in the saved information without the need to reconfigure the information again.
  - A user may be configured to allow up to four specific log-in periods.
  - A user may be configured to be automatically logged out of PAC Display Runtime if no activity has occurred for a specified amount of time.
  - A user may be configured to be required to change his or her password after a specified amount of time.
  - A user can now be required to log in when Runtime starts.
- A PAC Display project can now be archived and emailed to Opto22 Product Support.
- Now data sent to the control engine from a table control can be password protected such that each of the four tables in a table control can be configured to require a password to be entered in Runtime to allow a write to be performed from the table control.
- Table control data can now be configured for left, center, or right-justified data. Previously all data was left-justified.
- The new Scale Window tool allows you to resize a window and the graphics inside at the same time.
- Now you can configure Runtime to start with the Event Log hidden.

Runtime (Basic and Pro)

A user may now change his or her password.

Bug Fixes

Runtime (Basic only)

KB80143: A problem has been corrected where if a remote OPCServer location was specified, Runtime would ignore the setting and always use the local OPCServer.

KB80147: A problem has been corrected where PAC Display would have problems on PCs with dual-core processors.

Runtime (Basic and Pro)

The following problems have been corrected:

KB80285: The listing of SuperTrend historic log files in Runtime would occasionally display files that had a beginning date of January 2, 1601.
KB80224: Pressing 'Cancel' from Enter User Credential, may crash PAC Display Runtime

KB59384: Recipe upload from a table and a value was a QNAN, PAC Display would not update the recipe text file.

KB80110: Alarm Point persistence did not working correctly if the alarm point state reverted to Normal before the persistence time elapsed. If the alarm point went into an alarmed state again, the persistence time was reduced to the time left for the first alarm when it returned to Normal.

KB80076: The Synchronize at Runtime Startup feature was not working correctly.

Bug Fixes
Configurator (Basic and Pro)

The following problems have been corrected:

KB80116: In older versions of PAC Display dynamic attributes tied to charts treated the charts as discrete. Starting in version R8.1a attributes started to treat charts as values. When upgrading, PAC Display would not address this during the conversion. As a result the chart related features ceased working in the new version.

KB80306: Symbol Factory may not have launched correctly from the Edit menu or from the context menu.

==================================================================
PAC Display Professional R8.1i
PAC Display Basic R8.1i
PAC Project R8.1008
March 7, 2008

Bug Fixes
Configurator (Basic and Pro)

The following problems have been corrected:

KB80028: Display problems sometimes occurred when copying and pasting polyline, polygon, or curve graphics in a PAC Display Configurator window. After copying and pasting a graphic, sometimes only sizing handles appeared. When a group of graphics were copied and any one of the graphics in the group was a polygon type or curve, some of the graphics may have been missing when they were pasted in a window.

KB80066: If an Operator-Driven Dynamic Attribute, or a notification was configured that used a digital output point as the tag, then digital input points would no longer appear in the Tag Selection Dialog for Controller-Driven Dynamic Attributes unless the project was closed and re-opened.

Runtime (Basic and Pro)

KB80029: If a project was loaded into an already running instance of Runtime, historic log notifications may have only worked sporadically.
Enhancements

Configurator (Basic and Pro)
* When configuring a discrete controller driven dynamic attribute, Configurator no longer requires a bit index to be set for integer variables.
* Scratchpad variables are now accessible for any PAC-R1 or PAC-R2 configured in a PAC Control Strategy.

Bug Fixes

Configurator (Basic and Pro)

KB61229: A problem has been fixed where opening X-Y Plots from previous versions of ioDisplay or PAC Display would result in the plots not being displayed correctly.

Runtime (Basic and Pro)

KB61232: A problem has been fixed where the default window configuration for Runtime would not work properly. (This bug was inadvertently introduced in 8.1g, and was not present in previous versions.)

Bug Fix

Configurator (Basic and Pro)

KB60829: A problem has been fixed where on or after January 1, 2008, SuperTrend graphics and SuperTrend historic log files sometimes displayed dates that were six days ahead of the current date.

Enhancement

Configuring a graphic with the "Controller Status" Controller Driven Dynamic Attribute, no longer changes the fill color of the graphic to the default "Attached" color. The graphic will display the appropriate color in Runtime.

Bug Fixes

Configurator (Basic and Pro)

The following problems have been corrected:
KB60564: Configuring Notifications incorrectly allowed selecting digital point latches and counts.

Runtime (Basic and Pro)

KB60546: If a graphic with an operator driven dynamic attribute was configured to close the current window and open one or more windows, and that graphic was given a hot-key, and the same window contained several graphics with operator driven dynamic attributes, then Runtime would sometimes crash.

KB60521: Recipe notifications were being sent even if the recipe download or upload failed, or the user canceled.

=================================================================================================

PAC Display Professional R8.1e
PAC Display Basic R8.1e
PAC Project R8.1004
November 30, 2007

Enhancement

For Operator Action, Alarming Setup, Historic, and SuperTrend log files, there is now an option to log the time in hundredths of a second.

Bug Fixes

Configurator (Basic and Pro)

KB60228: A problem has been corrected where a wrong error message displayed when PAC Display attempted to open up a newer project.

KB60436: A problem has been corrected where Configurator would not allow configuring security on computers using users and groups configured locally on a standalone computer that was either not part of a domain or that could not communicate with a domain controller.

KB49822: A problem has been corrected where after configuring an Alarm Point Notification option (Alarm or Acknowledge), the Enabled check box became locked or grayed out after closing the Alarm Configuration Window and then re-opening it. The only way to deselect the Enable box was to select either the Alarm or Acknowledge buttons and then immediately close that dialog window.

=================================================================================================

PAC Display Professional R8.1d
PAC Display Basic R8.1d
PAC Project R8.1003
November 16, 2007

Enhancement

Configurator (Basic and Pro)

When configuring an alarm point, if the Play Sound When Alarmed option is selected on the Setup tab of the Alarm Point dialog, but no global sound file
has been configured, a new message box allows you either to proceed without configuring a global sound file or to stop and configure the global sound file before proceeding. The old message box required you to configure a global sound file before proceeding. A similar message box is provided in the Configure ->Alarming Setup dialog if no global sound is configured (or a previously configured sound is cleared), and any alarm point has the Play Sound When Alarmed option selected. Previously, if no sound file was configured, you had to make sure no alarm point had the Play Sound When Alarmed option selected.

Bug Fix

Runtime (Basic and Pro)

KB60244: A problem has been corrected where if a recipe upload format file had one or more table indices preceded by a comment marker (i.e., /0: ), the recipe upload would never complete. The Cancel button would need to be clicked to end the upload.

KB60280: A problem has been corrected where if a Recipe Upload Dynamic Attribute was configured with the "Prompt For Name" option for a Destination File, the Prompt For Name dialog would default to the Format File directory, not the Destination file directory.

======================================================================================================
PAC Display Professional R8.1c
PAC Display Basic R8.1c
PAC Project R8.1002
November 2, 2007

Bug Fixes

Configurator (Basic and Pro)

KB59932: A problem has been corrected where attempting to change the Bit Index value to a value greater than 13 caused an error message to appear in PAC Display Configurator.

KB59832: A problem has been corrected where objects that were created with polylines having a line thickness greater than 1, and then grouped with other graphics, may have had sizing problems when leaving the Configure Dynamic Attributes dialog.

Runtime (Basic and Pro)

KB59789: A problem has been corrected where if PAC Display Runtime was running, and a change was made to a project in PAC Display Configurator, and you executed the File->Save Project and Load Runtime command, PAC Display Runtime would sometimes hang. In some cases it was necessary to reboot the PC.

======================================================================================================
PAC Display Professional R8.1b
PAC Display Basic R8.1b
PAC Project R8.1001
October 19, 2007

Bug Fixes

Configurator (Basic & Pro)

KB59775: A problem has been corrected where if a window that contained recently pasted or dropped metafiles had any of its properties changed (Window-Properties), the metafiles became invisible and could not be made to reappear. They were still in the window, just not visible.

KB59782. A problem has been corrected where if the Export button was clicked in the Configure->Alarm Points dialog, and no alarm points were currently selected, two incorrect messages were displayed. The first message informed the user that the dialog could not close. The second message said that the alarm points had been exported, when in fact, no alarm points were exported.

Runtime (Pro Only)

Modification: The unused tag referencing I.P address of 1.2.3.4 has been removed from the _O22Heartbeat_ group that is added to the OPC Server for heartbeat verification.

====================================================================================================
PAC Display Professional R8.1a
PAC Display Basic R8.1a
PAC Project R8.1000
October 8, 2007

New Features, Configurator
---------------------------
* Alarm points may now be exported from one project and imported into another project.

* When configuring or editing tags for dynamic attributes, notifications and triggers, you can now manually type in a tag name instead of having to select it.

* (Pro only) You can now find and replace refresh groups in the Find and Replace dialog box.

* In order to capture operator driven actions in the Runtime Operator Action Log, PAC Display can now be configured for users to log in and out.

* Alarm Points may now be configured to play a unique sound, and may be individually configured to play, or not play, a sound when in alarm state in Runtime.

* Individual Alarm Points may now be configured to show, or not show the alarm dialog when the alarm point goes into an alarmed state in Runtime.

* Global Operator Driven Permissions can now be configured to allow globally configured users to be able to access any security-configured operator driven dynamic attribute without the need to be specifically configured for that attribute.
* A new Allow Runtime Tooltips feature enables the user to place the cursor over a graphic in Runtime that has a Controller Driven dynamic attribute and display the current values in a pop-up tooltip.

* The following support has been added for Integer 64 type variables and tables:
  - Recipe Download and Upload files may now contain Integer 64 tables.
  - Historic Logs now log Integer 64 variables and tables.
  - Table controls now support both the reading and writing of Integer 64 table values.

* The Configure->Control Engines dialog box now shows the IP address of the control engine and the strategy file that is being referenced.

New Features, Runtime
=======================
* In order to capture operator driven actions in the Runtime Operator Action Log, there is a new top-level Security menu for logging in and out.

* In the SuperTrend Historic Log Files dialog box it is now possible to browse to a different folder and display SuperTrend historic files located in that folder.

* When enabled, values for all controller-driven tags are displayed in a pop-up tooltip when you place the cursor over a graphic configured with a Controller Driven Dynamic Attribute.

* If configured to allow editing, Integer 64 table elements may be directly written using the table tool.

Bug Fixes
Runtime (Pro Only)
================
KB59513: A problem has been fixed where historic data logs in PAC Display Professional did not resume logging if Runtime switched from the primary scanner (OptoOPCServer) to a backup server, and then reconnected to the original server. A backup server may or may not have be specified. This occurred if the historic logs were configured to always log data, or to begin logging based on a Start Trigger.

KB59684: A problem has been corrected where if a recipe download file was used as a recipe upload template file, and the file contained more than one CHART command, the upload would never complete and had to be canceled. Once the upload was canceled, shutting Runtime down failed to completely exit Runtime. Although Runtime was no longer visible on-screen, the process was still running and would have to be shut down using the Windows Task Manager.

Runtime (Pro and Basic)
=======================
KB59487: A problem has been fixed where application managers configured with the Append String option could fail at Runtime if the control engine was changed from the initial configuration. Regenerating the I/O scanner tag names did not correct the problem.
KB58672: A problem has been fixed where if an upload recipe results file with an integer or float table had more than 2048 consecutive elements, and the table was divided into more than one section (group of 2048 consecutive elements), then the indices for the sections after the first section restarted at 0. The table element values would be correct, but the indices incorrect.

KB58600: A problem has been fixed where a recipe upload could fail if the path to the format file was not in the same directory as the PAC Display project file. The message "Can't find format file" appeared.

==============================================================================
PAC Display Professional R8.0k
PAC Display Basic R8.0k
PAC Project R8.0010
July 27, 2007

Bug Fixes

Configurator (Basic and Pro)
-------------------------------------
(KB58574) A problem has been corrected where the recipe creation utilities were not enforcing the current 2048 consecutive-element limit on recipe format files. (both Upload and Download)

Runtime (Pro and Basic)
-------------------------------------
(KB58575) A problem has been corrected where Downloading or Uploading a recipe file that contained more than 2048 consecutive elements failed and sometimes caused the OptoOPCServer to crash.

(KB58576) A problem has been corrected where if an Upload Recipe file contained a table with more than 2048 elements split into different 2048-element sections, only the first section would successfully complete and sometimes caused Runtime to crash.

==============================================================================
PAC Display Professional R8.0j
PAC Display Basic R8.0j
PAC Project R8.0010
July 20, 2007

Bug Fixes

Runtime (Pro and Basic)
-------------------------------------
(KB58369) A problem has been corrected where a graphic configured with the "Control Engine Status" Controller Driven Dynamic Attribute was not working correctly in Runtime.

Runtime (Pro Only)
-------------------------------------

(KB58374) A problem has been corrected where after switching to a secondary OptoOPCServer, SuperTrend pens gradually get truncated from the left edge of the SuperTrend moving toward the right edge.

Enhancement

Configurator (Basic and Pro)
---------------------

An Allow Edit check box has been added to the Configure Table dialog box that allows you to control whether or not an operator can edit a table in Runtime.

=================================================================
PAC Display Professional R8.0i
PAC Display Basic R8.0i

Internal release only.

=================================================================
PAC Display Professional R8.0h
PAC Display Basic R8.0h
(PAC Project R8.0008)
June 8, 2007

Bug Fixes

Configurator (Basic and Pro)
---------------------

(KB57440) A problem has been corrected where points on an I/O unit created in OptoControl may have led to an incorrect formulation of the IOSCanner Tag, because the channel number was read as a number greater than 256.

(KB57683) A problem has been corrected where the bit index field was not enabled when configuring a discrete tag for a notification, if the project was from a previous version of ioDisplay or OptoDisplay.

Runtime (Basic and Pro)
---------------------

(KB57625) A problem has been fixed where if a historic log needed to obtain the name of the file from a controller string variable, the initial write of the log file would fail. Subsequent writes would succeed.

(KB57748) A problem has been fixed where if a historic log is logging data from more than one integer or float table, the data for the most recently changed table will replace the data for the other table(s) of the same type in the historic log, resulting in all tables apparently logging the same data.

(KB57870) A problem has been fixed where the Event Log Viewer Help button didn't bring up any help.

Enhancements

Runtime (Basic and Pro)
Better support was added for displaying Japanese, Chinese and other DBCS character sets when obtaining data from the OptoOPCServer.

PAC Display Professional R8.0g
PAC Display Basic R8.0g
(PAC Project 8.0007)
May 18, 2007

Bug Fixes

Configurator (Pro only)

(KB57527) A problem has been corrected where the message "Unable to load Board Objects" would appear when trying to perform the "Tools->Regenerate IO Scanner Tags" command if old high-density G4 analog boards were present in the OptoControl strategy referenced in the PAC Display project.

Runtime (Basic and Pro)

(KB57572) A problem has been corrected where the alarm log would occasionally fail to log the return of an alarm point from an alarmed state to the Normal state.

PAC Display Professional R8.0f
PAC Display Basic R8.0f
(PAC Project 8.0006)
May 7, 2007

Bug Fixes

Configurator and Runtime

(KB56759) If a table is copied and pasted in Configurator, and you click to edit the data in the new table in Runtime, nothing appears to be selected.

Bug Fixes

Configurator (Basic & Pro unless otherwise stated)

(KB57342) A problem has been fixed where Find | Replace did not work when replacing control engine for selected graphics on an item with Control Engine Status dialog

(KB57143) A problem has been fixed where the SuperTrend Remote Historical Logging option would not let you browse the network to select a remote PC. This option worked under Windows 2000 but not under XP.

(KB57385) A problem has been fixed where Synch controller time to PC time: noon (12:00 PM) and midnight (12:00 AM) were swapped.
A problem has been fixed where a graphic with an Operator Driven Attribute to open a window when selected by an operator may not have appeared to open the window. This could occur if the window had a window property of Always in memory and the window was already open. When the configured graphic was selected, the window did not appear in the foreground and did not have the focus.

Runtime (Basic & Pro unless otherwise stated)
-------

A problem has been fixed where if an Historic Log was configured with a Stop Trigger, an entry in the log file consisting only of commas may sometimes have appeared when the Stop trigger was detected.

A problem has been fixed where if a triggered event (i.e., a Recipe, Launch Application, etc.) was configured to obtain a file name from a string in the control engine, the retrieval of the file name would fail, causing the triggered event to also fail.

A problem has been fixed where if the "Display Message Box for New Alarm Points" was configured in Configure->Alarming Setup, the dialog occasionally failed to appear if an alarm point went into the alarmed state more than once.

A problem has been fixed where when a configured alarm point went into an alarm state, PAC Display/ioDisplay stepped through an alarm processing sequence to set the configured point's alarm characteristics (sound, color, notification, appearance in alarm window, etc.). If the point went out of the alarm state before ioDisplay finishes stepping through the alarm processing sequence, some initial alarm characteristics may not have been set, possibly causing undesirable results. For example, if an alarm point was configured to play a sound until it was acknowledged and the alarm processing sequence did not finish, the alarm message may never have appeared in the alarm window. As a result, the alarm could not be acknowledged.

=============================================================
PAC Display Professional R8.0e
PAC Display Basic R8.0d
April 7, 2007

Bug Fixes, Runtime

Runtime Logging now logs Discrete Toggles.

A problem has been fixed with Historic Logs, which were not working correctly on some triggered logs and would only log once.

No Change to Configurator
There are no bug fixes or changes of any kind for this version of Configurator. The version number was changed to R8.0e only to keep the version number the same as Runtime.

=============================================================
Bug Fixes

Configurator and Runtime

(KB56759) If a table is copied and pasted in Configurator, and you click to edit the data in the new table in Runtime, the edit box now correctly appears in the new table. Previously, the edit box did not appear, or appeared in the original table, not the new table.

Configurator

(KB56849) A problem has been corrected where R8.0c of PAC Display Runtime was unable to open some ioDisplay Pro 7.x projects. No windows would open, and none would be listed in the Window menu.

Runtime

(KB56851) Historical Logs now work correctly with strings using the new mechanism instituted in PAC Display (8.0a) to avoid constant calls for data refresh from OPCServer.

(KB56852) A problem has been corrected where, if an alarm sound was configured to "Play sound continuously until any alarm is acknowledged", and an alarm point had a conditional tag configured, if the point went out of alarm before it could be acknowledged, the sound wouldn't stop playing.

(KB56854) A problem has been corrected where if an alarm sound was set to "Play sound continuously until any alarm is acknowledged", and an alarm point had a conditional tag configured, if the sound was stopped, but the point went back into alarm, the sound would not restart.

=============================================================
Daylight Saving Time switch, the PC clock went from 1:59 am to 3:00 am, Runtime would never see 2:00 am and would not sync the control engine's clock.

**Enhancement, Runtime Basic and Pro**

The alarm log no longer logs the following:
- Alarm points that are in an Unknown state
- Alarm points that are not in alarm when Runtime starts.

=================================================================

**PAC Display Professional R8.0b**

**PAC Display Basic R8.0b**

March 9, 2007

**Enhancement, Runtime Basic and Pro**

Runtime has been enhanced to reduce round-trip network traffic to and from the Scanner when opening and closing windows.

**Bug Fixes, Configurator Pro**

(KB56431) A problem has been corrected where opening a 7.1 project in 8.0 would sometimes cause a crash on save.

**Bug Fixes, Configurator Basic and Pro**

(KB56429) A problem has been fixed where if control engines were deleted from a project, but dynamic elements (graphics, alarm points, etc.) that referenced those control engines were not deleted, the tags for those dynamic elements were still being added to the scanner at Runtime startup.

**Bug Fixes, Runtime Basic and Pro**

Runtime (Basic and Pro)

(KB56430) A problem has been fixed where if an operator-driven dynamic attribute with configured security was successfully enabled by an operator, the Runtime Operator Log always reported the logged-on user as the operator performing the action, even if it was a different operator who logged in to Runtime to perform the operation.

=================================================================

**PAC Display Professional R8.0a**

**PAC Display Basic R8.0a**

March 1, 2007

**New Features, Runtime**

Now you can use a table control to manage string tables, as well as integer and float tables. Individual integer, float, and string table values can be changed directly.

**New Features Configurator**
* When configuring Operator Driven Dynamic Attribute, Read and Clear, two additional analog point attributes, Minimum and Maximum, have been added to the Actions drop-down list.

* String tables are now configured in the table control the same way as integer and float tables.

* New recipe file utilities provide an easier way to create, edit, and validate recipe files.

* The Delete Window dialog box now allows deleting multiple windows.

* When configuring Historic Logs or SuperTrend logs, a Weekly rollover period may now be selected. The File dialog box now has an option for the day of the week.

* Now a single Historic Log point can not only log integer and float table ranges, but also string table ranges as well.

* A new deadbanding feature is now available for combined SuperTrends that results in smaller, more manageable log files.

**Bug Fixes, Configurator**

* (KB54082) A problem has been resolved where if a window containing a XY-plot graphic had its window properties changed, and then the graphic was resized, Configurator would crash.

* (KB55259) A problem has been fixed where where the onscreen keyboard was requesting input through the actual keyboard when opening password protected windows.

* (KB55618) A problem has been fixed where if a metafile was pasted into a PAC Display window, or dragged into the window from SymbolFactory, and then duplicated (Edit->Duplicate), the duplicated metafile was not visible.

* (KB55747) (Pro) Adjustment: If a tag is desired from module that is configured with a point feature that is not supported by the MMIO Scanner, it is no longer necessary to go to Configure>Runtime>Io Units tab and deselect the IO Unit, thereby forcing Configurator to generate CONT scanner tags for all modules on that IO Unit.

  Now, the incompatible tags will automatically be generated with CONT tags. (Basic) In the case above, PAC Display Basic would generate an invalid Item Id. Now Basic mimics Pro for these incompatible tags.

* (KB55840) A problem has been fixed where "everyone" would show up in Non-English Operating Systems in Configurator when configuring security for an operator-driven dynamic attribute.

* (KB55854) A problem has been fixed where if no window was open, and a user clicked on the toolbox in an empty area below the first row of tools in the tool box, Configurator would crash.

**Bug Fixes, Runtime**
* (KB53303) A problem has been fixed where an alarm point configured as a float value was truncated when enabled by a discrete trigger and displayed in an alarm graphic. When the alarm point went back to its normal state, the value displayed remains truncated.

* (KB53707) A problem has been resolved where the PAC Display Synchronize at Runtime startup (synchronizes control engine clock to PC clock) option and the time interval at which synchronization should occur, may not have worked for a user who did not run Configure Runtime in PAC Display Configurator.

* (KB55253) A problem has been fixed where if a PAC Display object was configured with an Operator Driven Attribute to open a password-protected window, and the wrong password was entered, the calling window was closed if Cancel was selected.

* (KB55302) A problem has been fixed where PAC Display stopped scanning if a float variable reached 3.4e38 or -3.4e38, and was referenced in a dynamic attribute by an PAC Display component such as an Alarm or SuperTrend.

* (XP only) A problem has been fixed where if a user was configured as ALLOWED in the security settings for an Output Dynamic Attribute, it made no difference. Anyone could access the Output Dynamic Attribute as long as their username and password were valid.

============================================================================
ioDisplay Professional R7.1j
ioDisplay Basic R7.1j
December 18, 2006

Bug Fixes – Configurator

* (KB55256) A problem inadvertently introduced in ioDisplay 7.1i has been corrected where functions that had to write to the hard drive would fail. This included historic logs, SuperTrends, alarms, etc.

============================================================================
ioDisplay Professional R7.1i
ioDisplay Basic R7.1i
December 11, 2006

Bug Fixes – Configurator

* (KB55175) Fixed a bug where, when configuring an XY-Plot, the "Show Legends In Runtime" checkbox would always be selected, causing the legends to always appear in Runtime.

* (KB55016) A problem has been corrected where if you try to set the priority of the Lo alarm point it would not stick when you exited and returned.

Bug Fixes – Runtime

* (KB55177) Fixed a bug where alarms, if configured with a Conditional tag would not always show the correct state. They wouldn't always appear if alarmed, and would still show if the condition evaluated to false.

* (KB55178) Fixed a bug introduced in R7.1g where if an Alarmpoint value was set by a tag, the alarmpoint never went into alarm.

* (KB54490) A problem has been corrected where if you created a short cut on your PC to run ioDisplay Runtime with a specific project, and the project's Alarming Setup was configured to locate the sound file in the project directory, the sound would not activate when the alarm was triggered.

**Enhancement – Runtime**

* (CR55179) Added enhancement where, if alarmpoints are in a NORMAL state at Runtime startup, they are NOT added to the History alarm. The NORMAL state now only appears in the History Alarm once the Alarmpoint returns from an alarmed state.

=============================================================================  
ioDisplay Professional R7.1h  
ioDisplay Basic R7.1h  
November 22, 2006  
Internal release only.  
=============================================================================  
ioDisplay Professional R7.1g  
ioDisplay Basic R7.1g  
October 23, 2006  
**Bug Fixes – Configurator**

* (KB51157) A problem has been fixed where ioDisplay might become unresponsive after importing a corrupt "Tocpidfp.smb" file from the \Support\3dSymbol folder.
* (KB51758) A problem has been fixed where the Offset feature in the Send Value dynamic attribute did not work as expected. The ‘offset’ value should be added to the tag’s current value, but instead the current value plus the offset was added each time.
* (KB52368) A problem has been fixed where ioDisplay Configurator crashed when a SuperTrend was configured to collect one point of data once a day, and then configured to display seven days of data.

**Bug Fixes – Runtime**

* (KB52200) A problem has been fixed where an ioDisplay project with a trend that has not been configured caused ioDisplay Runtime to crash when the project was run.

=============================================================================  
ioDisplay Professional R7.1f  
ioDisplay Basic R7.1f  
August 15, 2006  
ioDisplay 7.1f was an internal release only.  
=============================================================================  


Bug Fixes - Runtime

* (KB51612) A problem has been fixed where if the Alarming Setup was configured as "Play sound continuously while any alarm is active", and a .wav file longer than 1-2 seconds was chosen, the sound would not play until the alarm was acknowledged, and then play only once.

Bug Fixes - Configurator

* (KB51184) A problem has been corrected where copying a metafile within iodeDisplay could cause Configurator to crash or the metafile to disappear when the metafile is pasted or the undo feature is used.
* (KB51157) Opto 22 is currently looking into a problem where a bad symbol file in the Symbols subfolder causes Configurator to crash. The problem has been solved temporarily by removing the symbol, which will be returned when a permanent solution is found.

[PRO]
* A problem has been corrected where the I/O Unit Tags tab of Configure->Runtime wasn’t adding D64 I/O units.
* A problem has been corrected where the I/O Unit Tags tab of Configure->Runtime was adding pointer types.

Enhancements - Configurator

[PRO]
* A new Uncheck All / Check All button has been added to the I/O Unit Tags tab of Configure->Runtime.
* The I/O Unit Tags tab of Configure->Runtime has been enlarged.

Bug Fixes - Runtime

* A problem has been corrected where the Alarm Log file was not including the year.

Enhancements - Runtime

* Upload Recipe Results file no longer has square brackets around indexes.
* Upload Recipe Results file no longer has trailing space after last entry for a table.
Bug Fixes – Configurator

* The Preserve OptoDisplay compatibility checkbox in the Trend dialog has been removed. It was nonfunctional. To make trends display as they did in OptoDisplay, use Trend Backward Compatibility in the Runtime Setup dialog (Configure->Runtime).
* Corrected a problem where metafiles were disappearing for two reasons:
  1) Once the Undo buffer limit was reached, the oldest redo item was deleted. If this redo item contained a reference to a metafile, the metafile was deleted;
  2) (KB51150) Dragging and dropping a metafile from SymbolFactory or another application, and then modifying the attributes of the metafile was causing it to disappear.

New Features – Configurator

* Configuring automatic synching of control engines to PC time has been added in the Configure->Runtime dialog under the Control Engines tab.

[PRO]

* There is now an option in the Execute Menu Item Operator Driven Dynamic Attribute to display the Configuration Status dialog in Runtime.

Bug Fixes – Runtime

* Corrected a problem where the Sync control engine to PC time command would sometimes fail.
* Corrected a problem where on startup, occasionally there were erroneous messages stating that "AddItems failed" but no item names were shown.
* (KB51005) Corrected a problem where if AlarmPoints were configured to use a Discrete Conditional tag, the alarmpoint was ignoring the condition.
* Corrected a problem where if AlarmPoints were configured to use conditional tags, and the alarmpoint was triggered, and then the condition went false, the alarmpoint was not removed from the alarm graphics.
* Corrected a problem where if a Text Color attribute was set for a graphic, and then the text was changed (either by the strategy or a Send String command), the text was displaying as black, rather that retaining the previous color.
* Corrected a problem where the Alarm Graphics were not displaying the year when alarmpoints were added.

=====================================================================
ioDisplay Professional R7.1b
ioDisplay Basic R7.1b
April 7, 2006

Bug Fixes - Configurator

* (KB50840) Corrected a problem where if pasting a graphic into a window failed, Configurator was not properly releasing the clipboard. Configurator had to be closed to release the clipboard.
* Corrected a problem where the Tools->Regenerate IO Scanner Tags command was not generating tags for the Upload Recipe Destination File tag if "Mistic String" was selected.
Fixed a problem where clicking Cancel while the Tools->Regenerate IO Scanner Tags command was running would cause Configurator to hang.

**New Features - Configurator**

- Multiple alarmpoints may now be deleted at one time.

- The Configure->Runtime dialog now has two new options:
  - "Format Value Data With Commas" now allows the user to choose whether commas are displayed for value data. This option is selected by default.
  - "Trend Backward Compatibility" - This option displays Trend (not SuperTrend) data the same as OptoDisplay. OptoDisplay graphed Trend data as if the "Y-Axis" Label Position had been set to "None", even if labels were present. Selecting this option displays ioDisplay Trends the same way. This option is disabled by default.

**Bug Fixes - Runtime**

- A problem has been corrected where on rare occasions, if a project contained large numbers of alarmpoints, not all of the alarmpoints were being added to the OPC Server.

[PRO]

- A problem has been fixed where the Window Menu would occasionally still display closed windows as being open, and vice versa.

- A problem has been corrected where the View->Configuration Status dialog was not showing all IO Units.

- A problem has been corrected where some Windows tags were not being added to the scanner when they belonged to the same group as other tags in the same window.

=============================================================================

**ioDisplay Professional R7.1a**

**ioDisplay Basic R7.1a**

March 8, 2006

Information in this README file applies to both versions unless otherwise indicated with [BAS] or [PRO].

**New Feature - Configurator and Runtime**

Added support for SNAP-PAC-R1 and SNAP-PAC-R2.

**Bug Fix - Configurator**

- A problem has been remedied where High Density Digital I/O Scanner Tags were being generated incorrectly.

[PRO]

- When selecting a element of a string scratchpad table, Configurator now correctly limits the maximum element to 63. Previous versions allowed selecting elements up to 10,239.
Bug Fixes – Runtime
------------------------

[PRO]
* (KB49885) A problem has been corrected where enabling or disabling a SuperTrend pen in Runtime was causing ioDisplay to crash.
* A problem has been corrected where ioDisplay Runtime would either fail to connect to the backup server, or randomly crash. This would occur if a redundant OPC Server had been configured, and the primary OPCServer was not available at Runtime start-up.

[BAS]
(KB49872) Trends would stop graphing data if all monitored tag values remained unchanged for a period of time.

Enhancements – Runtime
------------------------

* Trend scaling has now been modified as follows:
  If the Y-Axis "Label Position" is set to "None", all pens are displayed and are scaled proportionally to the height of the Trend graphic; if the "Label Position" is set to any other setting, only pen data falling in the Y-Axis "Label Range" of values is displayed.

[PRO]
* Failure to remove groups or items from the OPCServer now only displays error messages in the Event Log if ioDisplay is able to communicate with the server.
running the OPCServer, not the PC that is running ioDisplay Runtime (if different). Also, this command is not available in ioDsrX.pro.exe.

Additions - Runtime
---------------------

A menu item under the "View" menu allows syncing all control engines to the PC time; Note: this command syncs all controllers / control engines to the time of the PC that is running the OPCServer, not the PC that is running ioDisplay Runtime (if different). Also, this command is not available in ioDsrX.pro.exe.

Bug Fixes - Configurator
------------------------

A problem has been fixed where tags in table controls were not getting properly updated when executing the "Tools > Regenerate IO Scanner Tags" command.

Bug Fixes - Runtime
---------------------

[PRO]
* (KB49757) A problem has been fixed where the time display in Alarms was displaying only minutes and seconds, and omitting the hour.

[BAS]
* The "Sync All Control Engines to PC Time" Operator Driven Dynamic Attribute now works correctly when multiple control engines are configured.

=================================================================
ioDisplay Professional R7.0c
ioDisplay Basic R7.0b

January 19, 2006

Enhancement - Configurator
------------------------

* The AutoCorrect Tags feature now uses substantially less memory and GDI resources.

Bug Fixes - Configurator
------------------------

* (B50630) The AutoCorrect Tags feature no longer repeatedly misses some tags.

[BAS]
* A problem fixed where displaying negative numbers would sometimes add an extra comma before the number.

Bug Fix - Runtime
------------------
* (KB50631) A problem has been resolved where periodically a "TValue::Get" error message would be displayed indicating a NULL value type had been requested. This would occur when both Send Discrete and Send Value dynamic attributes were configured for a graphic, and the Runtime Operator Action Logging feature was enabled.

=============================================================================

ioDisplay Professional R7.0b
ioDisplay Basic R7.0a

-------------------------------

January 12, 2006

Enhancements
-------------
* Metafile drawing code has been enhanced to minimize the appearance of random lines appearing on some metafiles.

[PRO]
* The application executables have been renamed to:
  ioDisC.pro.exe
  ioDisR.pro.exe
  ioDsrX.pro.exe

* Performing a Operator Driven Discrete Set now mimics previous versions of ioDisplay in setting an integer value where no bit index was specified to a +1 instead of a -1.

[BAS]
* Application executables have been renamed to:
  ioDisC.basic.exe
  ioDisR.basic.exe
  ioDsrX.basic.exe

Bug Fix
-----------
[BAS]
* A problem has been resolved where the message, "Unable to Load PID Objects" would appear when configuring tags in certain projects in ioDisplay Configurator Basic.

=============================================================================

ioDisplay Professional (R7.0a)
ioDisplay Basic (R6.2a)

-------------------------------

December 8, 2005

ioDisplay software is now available in two versions: ioDisplay Basic and ioDisplay Professional. Information in this README file applies to both versions unless otherwise indicated with [BAS] or [PRO].

For information about the differences between Basic and Professional versions of ioProject software applications, see the ioProject Professional 7.0 Release Notes (Opto 22 form 1599). This document is included with all ioProject software and can also be downloaded

[PRO] ioDisplay Professional adds several new features:

* Support for Ethernet link redundancy using the dual Ethernet network interfaces on SNAP PAC controllers. You can designate primary and secondary control engines; if the primary is not available, ioDisplay Pro will switch to the secondary control engine. For maintenance or testing, you can also manually switch control engines.

* Conversion of OptoDisplay projects to ioDisplay projects.

* Connection to FactoryFloor controllers running OptoControl strategies. (SNAP-LCM4 with M4SEN3ET-100 adapter card only.)

* Ability to read and write I/O unit data through the control engine as well as directly from the I/O unit itself. This ability means you can set up segmented networks using a SNAP PAC controller, with one Ethernet interface used for the control network and one to communicate with hosts. (ioDisplay Basic, in contrast, must talk directly to I/O units.)

* Primary and secondary scanners. As with control engines, if the primary is not available, ioDisplay Pro will switch to the secondary. You can also manually switch scanners.

* Real-time overview of control engine and I/O unit status.

* Access to Scratch Pad bits, integers, floats and strings; pointer variables; PIDs; event/reactions; and limited support for Integer 64 variables.

* The ability to replace controllers, item names, table and bit indices for windows, alarm points, historic logs, sounds, triggers, and so on, for the entire project.

[BAS] Enhancements
---------------------

* ioDisplay Basic is very similar to the previous ioDisplay version 6.1, with the addition of support for new SNAP PAC controllers.

Bug Fixes
---------

The following issues have been resolved:

* Digital input and output points are visible and can now be added to a Historic Data Log.

* ioDisplay will not unexpectedly terminate for some Runtime windows containing Windows metafile graphics (.wmf or .emf).

* Some bitmaps were focus-frame and beep enabled inadvertently;
this problem has been fixed.

* RAM used for a SuperTrend is now correctly shown in kilobytes (KB) rather than megabytes (MB).

* Negative values in ioDisplay windows are correctly shown. (Previously, some had an extra comma.)

* Lo alarms associated with a tag under Setup By Current Value are triggered correctly.

* Historic logging works correctly. (The problem occurred when a new control engine was used and the log file name was created from a String Name.)

* An erratic good/bad data state associated with a 64-bit integer tag or a 64-bit integer table element has been fixed.

==================================
ioDisplay Software R6.1a
May 31, 2005

Enhancements
-----------

* Support for SNAP high-density digital input and output modules:

  * SNAP-IDC-32
  * SNAP-ODC-32-SRC
  * SNAP-ODC-32-SNK

Each of these modules provides 32 digital input (SNAP-IDC-32) or 32 digital output (SNAP-ODC-32-SRC and SNAP-ODC-32-SNK) points, for a total of up to 512 digital points on a 16-module mounting rack. Features differ from those in standard digital modules; for details, see Opto 22 form #1556, the SNAP High-Density Digital Module Data Sheet.

* There is a new operator-driven "Read and Clear" dynamic attribute for reading a tag value and then clearing (reset) it. The following values can be read and cleared:

  * Counts (returns an integer value and then clears counts)
  * On time total
  * Off time total
  * Latch (ON)
  * Latch (OFF)
  * On pulse measure
  * Off pulse measure
  * Period

* In the operator-driven "Send Value" dynamic attribute, values can now be formatted as hexadecimal numbers.

* A SuperTrend object’s y-axis can now be scaled logarithmically.

* An individual draw window in an ioDisplay project can now be exported, saved as a file, and then imported into another ioDisplay project. The exported window file contains all the objects and tags that were in the original window.
Exporting and importing draw windows is a convenient way to reuse the same window in different ioDisplay projects.

* Each drawing tool in the toolbox now has a shortcut key associated with it to make selecting and switching between tools easier and faster. To choose a tool, just press the corresponding key on the keyboard. Hold the cursor over a tool to find out which shortcut key is associated with it.

* Added “Regenerate IO Scanner Tags” item to Tools menu.

* Space and NULL characters are now removed from an Upload Recipe results file.

* Vertical and horizontal spacing of objects has been improved.

* The “Disk Full” error message is now more specific. This error is now also reported in the Event Log.

Bug Fixes
--------
The following problems were addressed in this release of ioDisplay:

* ioDisplay Configurator would crash if the user security group(s) and/or user(s) specified in the project were not present on the local domain.

* Alarmpoints were not always correctly added to the Runtime scanner.

* If an alarm sound was removed from an alarm and “Play until Acknowledged” was selected, the sound removed still played for that alarm.

* The “Alarmpoint Controller Status” tag is now sent to the Runtime scanner.

* For a PID loop, the IP address and port can now be configured correctly.

* Incorrect PID Item Names were being generated occasionally

* For a PID loop, the "Out Hi Clamp" and "Out Lo Clamp" values were being sent to "Input Under Range" and "Input Over Range".

* The auto/manual flag for a PID loop was not toggleable or settable.

* The "opening window" message is now only displayed if Runtime is the active application.

* When logging value changes, the operator action log file would incorrectly indicate that the "previous value" was always zero.

* In Configurator, the "Save Metafile As" command did not correctly save metafiles to disk.

* String writes with space or NULL strings were not working.

* SymbolFactory location is now predefined to reduce possible installation problems.

* Autocorrect tags now checks for available display resources on the computer.

* Historic log triggers were not added to the correct scanner group.

* Historic logs did not perform an initial scan when a trigger event occurred. Subsequent scans functioned correctly.

* Selecting and moving a large number of metafiles (usually 50 or more) on screen sometimes caused display problems.

===============================================================================


ioDisplay Software R6.0a
October 1, 2004

Enhancements
-------------
* An expanded testing regimen has improved both the reliability and performance of the software over the previous version, ioDisplay 5.1. In particular, ioDisplay Runtime now opens and starts large ioDisplay projects much faster than before.
* Recipes now support up to 2048 entries per table.
* Numeric table objects now support up to 500 elements per table.
* When configuring a SuperTrend, the estimated amount of memory the SuperTrend will use is now shown.
* When using an ioDisplay project in Runtime, individual SuperTrend pens can now be either hidden or disabled.

Bug Fixes - Configurator
------------------------
* Fixed a problem in the Configure Tag dialog box where, if the backspace key was pressed when the cursor was in the Element field, the Start Index and Number of Elements fields would become active. This would allow table ranges to be entered where they are not allowed.
* Corrected an error that occurred where a duplicate control engine ID was sometimes used when a new control engine was added to an ioDisplay project.
* Fixed a bug where trigger names sometimes did not appear in dialog boxes.
* Fixed a problem in the Configure Dynamic Attributes dialog box where, when using the Tab key to move between the location fields, objects would move around on the screen.
* Corrected a problem where AutoCorrect tags did not include cleared tags that were imported from a project created in ioDisplay 1.0.
* Fixed a bug where column widths for numeric table controls were not saved correctly.

Bug Fixes - Runtime
-------------------
* Corrected the following problems in using recipes:
  - Float tables in a recipe download didn't work.
  - Recipe downloads and uploads would fail if ioDisplay wasn't monitoring any tags for the control engine specified in the recipe file.
  - When uploading and downloading recipes, a control engine string couldn't be used for the name of the destination file.
  - Notifications were not working after uploading or downloading a recipe.
  - Recipes weren't working if comment lines were embedded throughout the file. In the upload results file, any comment lines were written at the
- An uploaded file could not be subsequently downloaded if brackets [], were used around indices.
- A blank line at the end of a file could cause Runtime to freeze.

* Fixed the Silence/Unsilence alarm feature to operate correctly.

* Corrected a problem where alarm sounds did not work correctly when combined with the Silence/Unsilence alarm feature.

* Fixed the Offset feature to operate correctly.

* Fixed the alarm point notifications to operate correctly.

* Corrected a problem where historic logging did not work correctly when choosing the option From Strategy.

* Fixed a bug where historic logs would sometimes display only commas for data, and display data at twice the refresh time or faster.

* Fixed a problem when triggering an external application that used an appended string in the command line (for example, "C:/notepad.exe myfile.txt").

* Corrected a problem where a backup controller would sometimes not operate.

* Corrected a problem where the Toggle Discrete dynamic attribute would not work correctly when the object also had other dynamic attributes configured.

* Fixed a problem where notifications were not working correctly for the Application Manager and Historic Logs.

* Fixed a bug where SuperTrend historic logs started with the date 1601.

* Fixed a bug where XY plots did not correctly display graphed data.

* Corrected a problem with color text in a graphic where, if the text was changed but the Color dynamic attribute for the text was not changed, the new text would display in default Configurator black.

Known Issue -- Runtime
----------------------
Some customers set up ioDisplay Runtime to run automatically on a technician’s PC with no other applications available. In some cases, Windows operating services that must run on the PC before ioDisplay Runtime opens may take too long to launch. If this happens, a dialog box will appear stating that a necessary service is unavailable, and ioDisplay will not open. If this situation occurs, you need to add a delay to the ioDisplay launch.

Here’s how:
1. Right-click on the ioDisplay Runtime icon in the Startup menu or folder, and choose Properties from the pop-up menu.
2. In the Properties dialog box, add a delay in seconds at the end of the Target field (outside the quotation mark), in the format <space><delay value>. For example, to add a 20-second delay, you would type a space and then 20 as shown below:
   "C:\Program Files\..\ioDispR.exe" 20
3. Check how Runtime launches to make sure the delay is the right length, and adjust the delay value if necessary.

===============================================================================
ioDisplay Software R5.1d
June 23, 2004

********** IMPORTANT ************ IMPORTANT *********** IMPORTANT ***********
ioDisplay R5.1d is distributed as a software patch, not as a standalone installation program. To use this patch, ioDisplay 5.1b must already be installed on your computer. See the instructions below for more information.

********** IMPORTANT ************ IMPORTANT *********** IMPORTANT ***********

Installing ioDisplay R5.1d if ioDisplay R5.1b Is Already Installed
------------------------------------------------------------------
Do the following:

1) Exit ioDisplay Configurator and ioDisplay Runtime applications if they are currently running.

2) Download the file ioDisplay_patch_R51d.zip from the Opto 22 Web site at the following link:


3) Uncompress the ZIP archive using WinZip or a similar program. The three .EXE files in this archive will replace three older files (R5.1b) with the same filenames.

4) Now find the ioDisplay directory on your computer. By default, ioDisplay is installed in the following location:

   c:\Program Files\Opto22\ioProject Software\ioDisplay

5) Drag or copy the three files you uncompressed into the ioDisplay directory. When a prompt asks if you want to replace existing files, click Yes.

ioDisplay R5.1d installation is complete.

Installing ioDisplay R5.1d if ioDisplay R5.1b Is Not Installed
--------------------------------------------------------------
Do the following:

1) Exit ioDisplay Configurator and ioDisplay Runtime applications if they are currently running.

2) Install ioDisplay R5.1b on your computer. If necessary, download the installer from the Opto 22 Web site at the following location:


NOTE: You must purchase and register ioDisplay software if you have not already done so. Once registered, you can request a password from the Opto 22 Product Support group at support@opto22.com.

3) Download the file ioDisplay_patch_R51d.zip from the Opto 22 Web site at the following link:


4) Uncompress the ZIP archive using WinZip or a similar program. The three .EXE files in this archive will replace three older files (R5.1b) with the same filenames.

5) Now find the ioDisplay directory on your computer. By default, ioDisplay is installed in the following location:

   c:\Program Files\Opto22\ioProject Software\ioDisplay

6) Drag or copy the three files you uncompressed into the ioDisplay directory. When a prompt asks if you want to replace existing files, click Yes.

   ioDisplay R5.1d installation is complete.

Bug Fixes -- Configurator
-------------------------
* Corrected a "duplicate control engine ID" error that occurred when a control engine was added to an ioDisplay project.

* Corrected a problem where tags that had been cleared weren't included when using AutoCorrect Tags on a project imported from ioDisplay R1.0.

* Fixed a bug that caused trigger names to sometimes be displayed incorrectly in dialog boxes.

* Corrected a problem in the Tag Configuration dialog box where pressing the Backspace key when the cursor was in an element field would make the Start Index and Number of Elements fields active. This allowed table ranges to be configured, even if the tag being configured was not a table.

* Fixed a bug in the Configure Dynamic Attributes dialog box that occurred when using the Tab key to move between controls.

Bug Fixes -- Runtime
---------------------
* Multiple fixes to recipe handling:

  - Corrected a problem where recipe float tables were not downloaded correctly to the control engine running the ioControl strategy.

  - Fixed a bug where recipe downloads and uploads would fail if ioDisplay was not currently monitoring tags for the control engine specified in the recipe file.
- Corrected a problem where uploading recipes with didn't work correctly if the option Filename from String Name was selected.

- Fixed a problem where notifications didn't work after uploading or downloading a recipe.

- Increased the number of table entries that can be used in a recipe to 2048 per table.

- Corrected a problem where an uploaded recipe file could not be subsequently downloaded if brackets [ ] were used around table indices.

- Fixed a problem where recipe files wouldn't work if comment lines were used throughout the file.

* Corrected a problem where historic logging didn't work correctly if the option Filename from String Name was selected.

* Fixed a problem where alarm point notifications did not work correctly with Application Manager and Historic Logs.

* Corrected an error with toggling discrete tags that occurred when the tag was configured with another dynamic attribute.

* Fixed a problem where the Offset feature didn't work on the Send Value dynamic attribute.

* Corrected an error where a window state could not be configured by appending a string in a command line.

* Fixed a bug where historic logs would sometimes display only commas for data, and sometimes display data at twice the refresh rate or faster.

* Corrected a problem so historic SuperTrends no longer start with the "1601" date.

* Corrected a problem where alarm sounds didn't work when used in conjunction with the Silence/Unsilence Alarm feature.

======================================================================
ioDisplay Software R5.1c
April 27, 2004

ioDisplay software R5.1c was made available briefly as a beta version to a small number of testers, but this version was never formally released.

======================================================================
ioDisplay Software R5.1b
February 27, 2004

Enhancements
-----------
* In ioDisplay Runtime, multiple "not connected" and similar error messages appear when an ioDisplay project starts. You can now choose whether to have these initial messages displayed. To hide or show these error messages, in ioDisplay Configurator select Configure-->Scanner Location and then select or
deselect the "Enable Bad Quality/Not Connected Errors" checkbox.

* In the Scanner Location dialog box, the location "This computer" is now selected by default.

Bug Fixes
---------
* On digital points configured as counters, counters are now displayed correctly.

* Correct Windows Help files for this version of ioDisplay are now installed.

* Corrected error when a Historic Log is configured to get the filename from the controller. The Historic Log would not be created and a scan error (undefined) would be displayed.

* Fixed problems in the View->Control Engines dialog box. Previously it still showed re-enable times. Also, if a control engine was not connected, it still said "Attached" even if no physical control engine existed.

* If a control engine was not initially attachable, graphics for that control engine were not correctly displaying the "Detached on Error" color.

* A trigger is no longer required to start or stop historic logs. Before, if a historic log was configured with no triggers, nothing would get logged.

* Strings can now be written to string tables.

* Recipes containing chart commands now work correctly.

* Corrected problem when a window had the "Always in memory" box checked in Configurator, and then was closed in Runtime. Previously the data was still being scanned; now the group is disabled on the server so that no scanning takes place until the window is re-opened.

* Fixed an error when trying to import an invalid metafile.

* Graphic color changes for Last Known Value or Comm Error now occur as the graphic objects are being scanned instead of occurring all at once.

* When multiple control engines must be monitored, selecting the Control Engine Status input dynamic attribute now shows the control engine that has the most critical status. A control engine's status, however, can only be monitored if the control engine is already referenced elsewhere in the ioDisplay project, and the referenced item is in an active ioDisplay window.

======================================================================
ioDisplay Software R1.0b
February 1, 2002

Enhancements
-----------
* The ioDsrX version of Runtime now has the View->Controllers menu option available.

Bug fixes:
---------
* Selecting integer and float table ranges when configuring tags is only allowed if configuring an XY Plot or Historic Data Log points.

* The option "Play sound continuously" now works correctly when using alarm points that are not inserted into an alarm graphic.

* Deadbands for floats now work when configuring "Text In From Controller" Dynamic Attributes.

* The "Switch Control Engines" menu option now appears correctly in Runtime.

* Sending Discrete values to bits 0 through 31 of Integer64 types now works correctly in Runtime.

* Metafiles are now properly pasted after being copied.

* Repeatedly sending discrete values no longer locks the controller.

=====================================================================
Initial Release
ioDisplay Software R1.0a
October 15, 2001

Known Issues
-----------
* When running ioDisplay Configurator under the Windows 2000 operating system, the font used to format text in a text box may change as you edit or change the text box. This problem does not occur when the ioDisplay project is run in ioDisplay Runtime.

OptoOPCServer
OptoOPCServer R9.2a
PAC Project R9.2000
February 29, 2012

Enhancements:
Added new Item IDs for pulsing, point configuration, diagnostic status read area items, and SNMP.

Bug Fix:
KB81856 PAC Display Runtime could not connect to OptoOPCServer on Vista or Windows 7 when the two programs were on separate computers.

=====================================================================
OptoOPCServer R9.1a
PAC Project R9.1000
July 18, 2011

Bug Fixes:
KB81316 'Out of service' errors reported in PAC Display.
KB81087 OptoOPCServer Item ID tag names are not displayed for PID items.

===============================================================================
OptoOPCServer R9.0b
PAC Project R9.0002
June 22, 2010

Bug Fix:

KB81001 Long start-up delay for PAC Display on Windows Vista and Windows 7.

===============================================================================
OptoOPCServer R9.0a
PAC Project R9.0001
June 17, 2010

Enhancement:

Added support for Controller Redundancy in the OptoOPCServer scanners.

===============================================================================
OptoOPCServer R8.2c
PAC Project R8.2009
March 20, 2009

Enhancement:

The internal scanning interval of data from Opto devices has been changed to coincide with the interval requested from OPC clients. Previously, the scan interval was half of the requested interval. In other words, it was scanning twice as often as requested.

Bug Fixes:

KB80553 Pointer variable tags reference the wrong tag in Browser Configurator
KB80240 Numerous writes by an OPC client may delay data updates

===============================================================================
OptoOPCServer R8.2b
PAC Project R8.2006
December 15, 2008

Bug Fix:

KB80429 Cannot read IUNIT;ENABLE OptoOPCServer status

===============================================================================
OptoOPCServer R8.2a
PAC Project R8.2000
June 19, 2008

Bug Fixes:

KB80120 PAC Display Runtime clients may not switch to backup control engine


78
Possible Opto Browser Configurator problems if tag file pathname includes an '!

OptoOPCServer stops updating data tag group when invalid memory map address is accessed

OptoOPCServer R8.1e
PAC Project R8.1008
March 7, 2008

Bug Fixes:

(KB80042) Synchronous Reads of array information were causing a memory leak to occur.

(KB80043) The OPTO Easy OPC VB Forms example would not compile because of a missing End If statement in TestMainForm.frm. Also, the ReadItem function in CItem.cls was not handling reads from cache correctly.

OptoOPCServer R8.1d
PAC Project R8.1007
February 1, 2008

Bug Fix:

(KB61230) A problem has been corrected where Opto Browser Configurator was not displaying the correct tags for a digital input configured as a quadrature counter from PAC Manager.

OptoOPCServer R8.1c
PAC Project R8.1005
December 14, 2007

Bug Fixes:

1. (KB58657) Fixed the CONT, MMIO, and OC Scanners so that they do not have errors when a SyncRead is performed on multiple items.

2. (KB60509) Fixed writing multiple items so that when it succeeds, it returns the correct success code.

OptoOPCServer R8.1b
PAC Project R8.1004
November 30, 2007

Enhancements:

1. The number of items that the server can add is no longer limited to 128K.

2. Increased the initial size of item arrays and the size by which they will grow to decrease memory thrashing.

Bug Fixes:

1. (KB58925) Changed the way that OptoOPCAuto.dll removes groups to prevent the server from hanging when accessed by VB clients.

2. (KB60298) Fixed the MMIO_Items.def and MMIO_Cache.def files to allow access to more than 16 PID Loops.

OptoOPCServer R8.1a
PAC Project R8.1000
October 9, 2007

Enhancements:

1. Opto Browser Configurator can now generate Pointer Variable, Integer 64 Variable, and Integer 64 Table tags from PAC Control files.

2. Tag names can now contain hostnames in place of IP addresses for scanning Opto 22 devices.

OptoOPCServer R8.0d
PAC Project R8.0009
June 29, 2007

Bug Fixes:

1. (KB58125) A problem has been fixed where Opto Browser Configurator was not able to open .cdb files from OptoControl.

2. A problem has been fixed where occasionally, when a client would disconnect from OptoOPCServer, it would crash.

OptoOPCServer R8.0c
April 20, 2007

Bug Fixes:

1. (KB56892) Opto Browser Configurator was not recognizing SNAP-PAC-EB1 or SNAP-PAC-EB2 I/O Units from PAC Control or PAC Manager.

2. (KB56847, KB57015) Improperly formed controller table ItemIds from custom OPC Client programs were causing erratic quality values to be reported.

OptoOPCServer R8.0b
March 23, 2007

Bug Fix:

(KB56458) A problem has been corrected where stale data is now detected and correctly reacted to. When items are deactivated, they are not scanned. When subsequently activated, the value of those items are now freshened.
Bug Fix:

(KB55105) A problem has been fixed where CPU usage could climb as high as 30% of total system resources (when measured by Task Manager or Performance Monitor) when OptoOPCServer accessed the memory map of I/O units (MMIO) over a slow network, such as a VPN.

Enhancements:

To Browser Configurator:

1. Tags can now be generated that allow indirect access to I/O Unit data through the controller.

2. When reading .otg files, tags can now be generated that allow access to the expanded memory map on SNAP PAC devices. Also, High Density Digital points will be recognized and complete tags generated.

3. When reading .idb files, the following new tags can be generated:

   Controller
   Memory, Time, Date, SyncDateTime, StrategyName, ErrorCount, LastError
   Event Reactions
   ScanEnable, IsOccurring, HasOccurred
   PID (Mistic)
   Input, Output, Setpoint, Gain, Integral, Derivative,
   SetpointTrackInput, OuputTrackInput, OutputEnable, Auto, Active
   PID (Ethernet)
   Input, Output, Setpoint, Gain, Integral, Derivative, Auto, ScanRate
   I/O Unit
   Enable
   Digital Input
   OnLatch, OnLatchGetClear, OffLatch, OffLatchGetClear, Counter,
   CounterEnable, CounterGetClear, QuadCounter, QuadCounterEnable,
   QuadCounterGetClear, OnTimeTotalizer, OnTimeTotalizerGetRestart,
   OffTimeTotalizer, OffTimeTotalizerGetRestart, OnPulse,
   OnPulseGetRestart, OffPulse, OffPulseGetRestart, Period,
   PeriodGetRestart, PulsePeriodComplete, Frequency
   Digital Output
   TPOPeriod, TPOPercent
   Analog Input
   in, Max, MinGetClear, MaxGetClear

4. When reading .cdb files, the following new tags can be generated:

   Controller
   Memory, Time, Date, SyncDateTime, StrategyName, ErrorCount, LastError
   Event Reactions
   ScanEnable, IsOccurring, HasOccurred
PID
Input, Output, Setpoint, Gain, Integral, Derivative,
SetpointTrackInput, OutputTrackInput, OutputEnable, Auto, Active

I/O Unit
Enable

Digital Input
OnLatch, OnLatchGetClear, OffLatch, OffLatchGetClear, Counter,
CounterEnable, CounterGetClear, QuadCounter, QuadCounterEnable,
QuadCounterGetClear, OnTimeTotalizer, OnTimeTotalizerGetRestart,
OffTimeTotalizer, OffTimeTotalizerGetRestart, OnPulse,
OnPulseGetRestart, OffPulse, OffPulseGetRestart, Period,
PeriodGetRestart, PulsePeriodComplete, Frequency

Digital Output
TPOPeriod, TPOPercent

===============================================================================
OptoOPCServer R7.1a
April 7, 2006

Bug Fixes:
-------

* A memory leak was fixed that could occur when large numbers of string
  variables were continually added and removed from the server.
* (KB50037) A problem has been corrected where communications between
  OptoOPCServer and a device could sometimes fail resulting in a partial crash
  of OptoOPCServer. Communication to other devices would still be active, but
  the only way to recover was to restart the server.
* A problem has been corrected where occasional "out of service" errors could
  occur while rapidly adding and removing groups.

===============================================================================
OptoOPCServer R7.0c
February 2, 2006

Bug Fix:
-------

(KB49807) A problem has been corrected where the server would crash when
attempting to scan a string or string table strategy variable that no longer
exists. This might happen when the controller lost power and the strategy was
not saved to flash.

===============================================================================
OptoOPCServer R7.0b
January 26, 2006

Bug Fixes:
-------
* (KB49750) A problem has been fixed where client programs using OptoOPCAuto.dll could cause the server to fail if an item was added as inactive and later activated.

* (KB49750) A problem has been resolved where client programs using OptoOPCAuto.dll would not be able to modify the update rate for a group. Attempts to do so would set the update rate to 20ms.

-------------------------------------------------------------------------------

**OptoOPCServer R7.0a**
December 19, 2005

OptoOPCServer software is now available as part of the ioProject Professional software suite. You can also purchase OptoOPCServer separately. See the ioProject 7.0 Release Notes (Opto 22 form 1599) for more information. This document is included with all ioProject software, and can also be downloaded from the Opto 22 website at www.opto22.com.

Enhancements:
-------------

1. Added support for redundant Ethernet links using the SNAP PAC controllers’ two Ethernet interfaces. OptoOPCServer offers the ability to designate primary and secondary controllers. If the primary controller is not available, OptoOPCServer will use the secondary controller.

2. Can obtain I/O data through a SNAP PAC controller rather than having to talk directly with the I/O unit.

3. Since OptoOPCServer does not require an Ethernet connection to I/O units, a segmented control network can be created using the SNAP PAC’s two network interfaces.

4. Support has been added for FactoryFloor controllers running OptoControl strategies, so that OPC clients can now work with data on these legacy control systems.

Known Issues:
-------------

* When an ioDisplay project is configured to use redundant OptoOPCServers, ioDisplay or OptoOPCServer may stop operating or otherwise become unavailable. Contact Opto 22 Product Support for current information on this problem.

-------------------------------------------------------------------------------

**OptoOPCServer R6.1a**
May 25, 2005

Enhancements:
-------------

1. Added support for High Density Digital modules.

Bug Fixes:
---------

---

**README:** PAC Project R9.2000

83
1. The Browser Configurator will again allow editing of array type Item IDs.

OptoOPCServer R6.0a
October 1, 2004

Enhancements:
--------------

1. Digital point states and analog point engineering units can now be read from Ethernet-based controllers that are running OptoControl strategies.

2. Added ability select all items in the log by pressing Ctrl-A.

3. Added the number of items to the Group Information Tool Tip that is displayed when hovering over a group in the tree view.

Bug Fixes:
----------

1. Sync Write now converts from types other than the canonical type.

2. Items added to an inactive group are not scanned until the group becomes active.

3. When using IDataObject for subscription callbacks, float values now update correctly.

4. Transferring a very large browser database from the Browser Configurator to the server no longer fails.

5. The Browser Configurator is now able to open OTG files whose first point is an analog output.

6. Sync Write no longer has difficulty with empty BSTRs being represented by a NULL pointer.

7. Response times are not affected if groups are continually added and removed.

OptoOPCServer R5.1b
February 26, 2004

Bug Fixes:
----------

1. Reading very large data requests from UIO controllers would sometimes cause some elements of the data to change value for one scan cycle.

OptoOPCServer R5.1a
December 12, 2003

Enhancements:
--------------

1. Added support for new devices: SNAP LCE controller, and SNAP Simple I/O
brain.

2. Added support for PID Loops for the SNAP Ethernet devices that have added that new feature.

3. Added support for OptoControl variables - Integers, Floats, Strings, and their corresponding table types.

4. Scratch Pad Bits can now be accessed on SNAP Ethernet brains.

5. The extended Scratch Pad Integers and Scratch Pad Floats areas on Ultimate I/O can now be accessed by the exact index of the element.

Bug Fixes:
---------

1. Updates of array elements in the upper portion of the array would not always occur at the proper time.

===============================================================================
OptoOPCServer R5.0b
August 22, 2003

Bug Fixes:
---------

1. Attempting to load Browser Items files that resided in very long pathnames would result in strange and unpredictable behavior in the Browser Configurator.

===============================================================================
OptoOPCServer R5.0a
July 28, 2003

Enhancements:
-------------

1. Added support for Ultimate I/O brains and controllers.

2. Added a Browser Configuration utility that gives greater control of the tags that are available in the OPC Server's browser interface.

Bug Fixes:
---------

1. Performing asynchronous writes using the older IDataObject interface would result in memory leaks.

2. When removing a group, the corresponding data callback interface would sometimes not be released in the correct order, resulting in the server hanging.

3. When the server was remotely activated and a second client would connect, the server would crash if the log view was being written to. In this situation, the server is invisible and there is no need to write to the log view.

4. Changed the initial quality of items that haven't been scanned yet to "Not Connected" instead of "Bad".
5. When items were added to an inactive group, the group would be marked as active after the operation of adding items.

6. The server would crash if there was no group selected in the user interface and the Show Items menu item was chosen.

7. In AsyncIO::Read and AsyncIO::Write (as opposed to AsyncIO2::Read and AsyncIO2::Write), the server is supposed to return S_FALSE when any of the item handles are invalid. Also, no transaction should be queued up at this point. These functions were behaving like their AsyncIO2 counterparts which allow some item handles to be invalid and the remaining items would be included in a transaction that would result in a callback.

8. The number of lines displayed in the message log has now been limited to prevent overflows that could in some situations cause a memory leak.

===============================================================================
OptoOPCServer R2.0b
November 14, 2001

Bug fixes:
---------

1. String array items were being updated at every subscription interval instead of only when there was a change in the string data.

2. IOPCShutdown could not be Advised by clients meaning that this interface was not available to clients.

3. Using Generic Tags to specify access to memory map information would result in mixed up results (e.g. information for the second tag would be returned for the first tag).

4. Writing to the Scratch Pad Bits area of the memory map was not working correctly.

5. Transferring BSTR and all SAFEARRAY data on IDataObject (ver 1.0) subscriptions did not work correctly.

===============================================================================
Windows NT Installation Notes:
-------------------------------

Windows NT users must have write access to the registry and the WinNT\System32 directory to successfully install and use this product.

===============================================================================
Uninstallation of this Product:
-------------------------------

A utility is provided to uninstall this product. The utility will remove all registry entries and files previously installed with the following exceptions:
- The installation directory tree is not removed if any user-created files exist in it.
- The Win95/Win98 program folder or Windows NT program group is not removed if any icons have been added by the user.
Enhancements:

* Added support for G4EB2 brain (also includes part numbers G4D32EB2 and G4D32EB2-UPG).

* Added support for SNAP-IDC-32D module.

* Added support for the SNAP-OMR6-C and SNAP-OMR6-A modules.

Bug Fix:

KB81848 A problem has been corrected where some text was truncated in some dialog boxes when running PAC Manager in the Chinese version of Windows.

=====================================================================

Enhancements:

* Added support for modules SNAP-SCM-CAN2B and SNAP-IDC-32DN.

* Added a warning about the possible consequences of updating firmware on controllers and brains.

=====================================================================

Enhancements:

* Values can now be automatically refreshed on Inspect mode dialogs.

* Firmware can now be sequentially upgraded on multiple SNAP-PAC-SB devices using pass-through mode. Previously, if there were multiple SB brains on the same RS-485 link, the firmware could only be updated one unit at a time. Now you can enter the addresses of all the SB-series brains on the same RS-485 link, execute the update, and they will all be updated automatically.

=====================================================================

Enhancements:
* Added support for SNAP-AITM-4i and SNAP-AIRTD-1K modules.
* Changed the default scaling for the SNAP-AIPM-3 and SNAP-AIPM-3V modules.

**Bug Fixes:**

**KB81088** Incorrect microSD card function message in PAC Manager.

**KB81159** Cannot copy I/O units with PIDs in PAC Manager.

**KB81268** PAC Manager allows more than 24 data bits for SNAP-SCM-SSI module.

**KB81311** 'High Density Digital Input Module #' incorrectly displayed for Event in Configure Mode.

===================================================================================================================
PAC Manager R9.0c
PAC Project R9.0006
September 3, 2010

**Enhancement:**

The Scratchpad Integers Inspect mode dialog has been enhanced to behave the same as the Scratchpad Floats dialog. When an item is modified, it is marked automatically as changed.

**Bug Fix:**

**KB81079** 'Send Configuration to I/O Unit' dialog PAC Manager showing erroneous message in Log.

===================================================================================================================
PAC Manager R9.0b
PAC Project R9.0002
June 29, 2010

**Enhancement:**

Added support for SNAP-AIPM-3V module.

===================================================================================================================
PAC Manager R9.0a
PAC Project R9.0000
June 15, 2010

**Enhancements:**

* Added microSD Op Codes to the Status Write Inspect dialog.
* Added the ability to Enable/Disable the EtherNet/IP protocol in the Network Security dialog.
* Added Scratch Pad Triggers to the Configuration mode Event Messages dialog.
* Moved the location of initialization files from the "Install" directory to the "ProgramData" directory.

* Added support for the SNAP-PAC-SRA (Snap Redundancy Arbiter).

* Improved the labels and prompts in the Configure SSI Modules dialog to make it easier to use.

**Bug Fixes:**

KB80890 Network Key field for Wireless LAN might not be wide enough in PAC Manager.

KB80889 'Address of value to check field' in Alarm Events dialog may be cleared.

KB80866 Large Fonts affects screen displays in PAC Manager.

KB80865 SNAP-UP1-D64 and SNAP-ENET-D64 not listed when adding I/O units in PAC Manager.

=====================================================================  
**PAC Manager R8.5b**  
PAC Project R8.5001  
February 17, 2010  

**Enhancement:**

Added support for the SNAP-SCM-SSI module.

**Bug Fixes:**

KB80796 Upper Scaled Units incorrect for SNAP-AIRTD-10 Generic Point Type in PAC Manager.

KB80795 PAC Manager's Find OptoMMP Devices dialog displays incorrect IP address for wireless device.

KB80698 SNAP-AIPM-3 module channels 12 and 13 incorrectly displayed in PAC Manager.

KB80693 SNAP-IDC-32N input states not displayed in PAC Manager

KB80794 A configuration (.otg) file with a Generic OptoMMP Device crashes PAC Manager.

=====================================================================  
**PAC Manager R8.5a**  
PAC Project R8.5000  
September 4, 2009  

The version is now 8.5 to match the firmware version of the Wireless LAN devices.

**Enhancements:**

Support has been added for the following SNAP-PAC Wired+Wireless LAN devices:

- SNAP-PAC-S1-W  
- SNAP-PAC-S2-W  
- SNAP-PAC-R1-W  
- SNAP-PAC-R2-W

Bug Fixes:
--------

**KB80657** SNAP-Custom-AI points are not scaled correctly by PAC Manager

---

**PAC Manager R8.2f**
PAC Project R8.2010
May 1, 2009

Enhancements:
-------------

* Added support for the SNAP-IDC-32N digital input module.

* The Status Read page in Inspect mode now monitors several device settings and displays a warning icon if their value is out of the ordinary.

Bug Fixes:
--------

**KB80561** Unexpected results from PAC Manager's 'Digital Events - Expanded'

---

**PAC Manager R8.2e**
PAC Project R8.2009
March 19, 2009

Enhancements:
-------------

* Added support for analog input module AIPM-3.

* Added new PID Loop algorithm, Velocity - Type C.

* Added the ability to change the number that is displayed when a value is determined to be out of range. The Out Of Range Value can be edited on the Inspect mode Status Write dialog.

* Added the ability to display the raw counts measured from an analog point. This is the number of counts before any linearization or cold junction compensation is applied. This value is available on the Inspect mode Analog Point dialog.

Bug Fix:
--------

**KB80550** Changes to some PAC Manager Status Write items not saved

---

**PAC Manager R8.2d**
PAC Project R8.2005
December 1, 2008
Enhancements:
-------------
* Increased the number of serial ports that can be set for Turn Around Delay to accommodate devices such as the SNAP-PAC-S2.

* Added file compatibility with EtherNet/IP Configurator to facilitate data interchange between the two programs.

* Added support for the SNAP-IAC-K-16 and SNAP-IDC-HT-16 digital input modules.

Bug Fixes:
---------

**KB80324** PAC Manager may crash if no IP addresses are configured

**KB80420** When 'Change IP Settings' does not set IP address to 0.0.0.0

**KB80461** SNAP-CUSTOM-AI analog point options missing in PAC Manager

**KB80665** Extra communication ports displayed in PAC Manager

=====================================================================
PAC Manager R8.2c
PAC Project R8.2003
September 4, 2008

Enhancements:
-------------

The B3000-B serial brain has been added to the Loader Mode Firmware Update Utility.

=====================================================================
PAC Manager R8.2b
PAC Project R8.2002
July 31, 2008

Bug Fix:
--------

**KB80098** Importing PAC Manager configuration file with Ethernet I/O may cause problems in PAC Control

**KB80355** FTP login attempt may fail.

=====================================================================
PAC Manager R8.2a
PAC Project R8.2001
July 10, 2008

Bug Fix:
--------

**KB80072** Expanded digital events on I/O unit may not work as expected when configured from a PAC Manager .otg file

KB80247  PAC Manager incorrectly displays 64-bit scratchpad hex integers

===================================================================== 
**PAC Manager R8.1f**

PAC Project R8.2000
June 19, 2008

Enhancements:
-------------

1. Added the ability to modify 64-bit Integers in the Generic Read/Write dialog of Inspect mode.

2. Made Digital Events - Expanded much more flexible by allowing digital and scratchpad triggers and reactions to be on both the first or second trigger or reaction.

===================================================================== 
**PAC Manager R8.1f**

PAC Project R8.1007
PAC Project R8.1008
March 7, 2008

Enhancements:
-------------

1. Increased the number of COM ports to choose from when directly accessing an SB1 or SB2 brain.

2. When installing firmware, made the detection of error messages during the download more robust to handle firmware/hardware mismatches.

Bug Fixes:
----------

1.  (KB80052) When changing the Primary IP Address for a device, check the Secondary IP Address and Subnet Mask information to ensure there is no conflict.

===================================================================== 
**PAC Manager R8.1e**

PAC Project R8.1007
February 1, 2008

Enhancements:
--------------

1. Added a timeout field to the Ethernet tab of the Loader Mode Firmware Update utility.

2. Changed the display format of the Seconds Since Powerup item on the Status Read page in Inspect mode.

Bug Fixes:
-----------

1.  (KB61226) In where in the PID Loops Inspect mode dialog, the asterisk next to the loop number used to indicate if the PID Loop is configured was not being displayed correctly for loops beyond 31.
2. (KB80068) An unusual sequence of operations and brain states could cause Inspect mode to become confused, resulting in a timeout or a duplication of Device Names.

===================================================================== PAC Manager R8.1d PAC Project R8.1006 January 11, 2008 Enhancements: 
-------------- 1. Added Seconds Since Powerup to the Status Read page.
2. When Assigning an IP Address to an Opto 22 device, PAC Manager will now attempt to ping that address first to see if another device already has that IP Address.
3. On the Serial Modules, Wiegand Modules, Profibus Modules and Motion Modules dialogs in Inspect mode, the Module Type description is now displayed instead of just displaying the Module Type.

Bug Fix: 
--------

(KB60554) A problem has been corrected where in the SNMP Inspect mode dialog, the SNMP Trap Version was not being checked for out of range values.

===================================================================== PAC Manager R8.1c PAC Project R8.1004 November 30, 2007 Enhancements and bug fixes for this version of PAC Manager are listed below. See the PAC Manager User's Guide (Opto 22 form #1704) for more information on software features.

Enhancement: 
------------
1. Implemented a new compressed HTML Help system to replace the old WinHelp system.

Bug fixes: 
--------

1. (KB60177) The ability to create an I/O Unit from the flash memory image of another device was not working.
2. (KB60219) The View As Hex feature for Scratch Pad 32-Bit Integers would only display values in hexadecimal for the first 1024 items.

===================================================================== PAC Manager R8.1b PAC Project R8.1002 November 2, 2007
Bug fixes:
---------

KB54410 - Corrected a problem where when installing firmware to multiple devices of the same type, the "Cannot open local file" error would occasionally occur on one or more of the devices.

KB60031 - Corrected a problem where the Move Point dialog was malfunctioning when the destination device was a SNAP PAC and the point location was not on the first module.

KB60032 - Corrected a problem where when installing firmware, and the Sync Device Time To PC Time check box was selected, an unnecessary Power-Up Clear dialog box message would be displayed.

===================================================================== PAC Manager R8.1a PAC Project R8.1000 October 8, 2007
Enhancements:
-------------
1. Added support for SNAP-PAC-SB1 and SNAP-PAC-SB2 serial brains which includes the ability to inspect data through a direct serial connection from a PC to the device, or passing through a SNAP-PAC-S1 or SNAP-PAC-S2 controller's serial port to reach the device.

2. Added support for the SNAP-PAC-S2 controller.

3. Added support for analog 8 point input modules AIV-8, AIMA-8, and AICTD-8.

4. Added support for Scratch Pad 64-Bit Integers.

5. Renamed Timer Events to Digital Events - Expanded, and provided more choices for triggers and reactions which include, on/off latch, high density digital points, and scratch pad 64-bit integers.

6. High Density Digital points can now be configured for Watchdog.

7. Added a fourth port to the Communication Port Control dialog to account for the four serial ports on a SNAP-PAC-S2 controller. Each port can be configured for RS-232 or RS-485.

8. Improved Analog Bank Read in Inspect Mode to handle analog modules with more than two points.

===================================================================== PAC Manager R8.0f PAC Project R8.0009 June 29, 2007
Bug fix:
--------
(KB57925) Corrected a problem where in Inspect Mode, using a port number greater than 32767 could result in a negative port number being displayed after the Inspect window was closed and then re-opened.
PAC Manager R8.0e
June 8, 2007

Enhancements:
--------


2. Improved the Status messages when executing commands on the Status Write dialog.

Bug fixes:
--------

1. (KB57775) Corrected a problem where sending a flash memory image that contained analog modules to a SNAP PAC brain that did not have those same analog modules displayed an error.

PAC Manager R8.0d
May 4, 2007

Enhancements:
--------

1. Added three items to PPP Configuration. Connection Establishment Timeout, Echo Request Period, and Echo Request Retries.

2. Improved the wording in the Calibration dialogs for clarity.

Bug fixes:
--------

1. (KB57202) A problem has been corrected where Status Write Commands were not working after the 8.0c update.

2. (KB57247) A problem has been corrected where resizing of the Inspect Window on computers configured with Large Fonts did not work correctly. Information in the window was sometimes truncated.

3. (KB57243) Creating an I/O Unit configuration by directly reading from a SNAP-ENET-S64 or SNAP-UP1-M64 now works correctly.

PAC Manager R8.0c
April 20, 2007

Enhancements:
--------

1. The Inspect mode dialog is now resizable.

2. Pressing Enter in the Inspect mode dialog initiates a Refresh.
3. Holding down the Shift key while entering Inspect mode bypasses the initial attempt to read data.

4. Added a link on the Maintenance dialog to get the latest firmware.

Bug fixes:
----------

1. (KB57139) The Inspect mode Status Write command Switch To Loader Mode is not supported on some devices. A warning message is now displayed when this occurs.

2. (KB57140) Creating an I/O Unit configuration by directly reading from devices that have the expanded memory map now works correctly.

3. (KB57141) The number of points per address for the legacy devices SNAP-UP1-ADS, SNAP-UP1-M64, and SNAP-ENET-S64 is now correctly set at 64.

4. (KB57142) Corrected the Inspect mode Generic Read/Write dialog hex editing which was inadvertently broken by a previous update, but only showed up when a write-only area was inspected.

=====================================================================
PAC Manager R8.0b
March 23, 2007

Bug fixes:
----------

1. (KB56503) A problem has been corrected where when a point was given a name that was longer than 15 characters, and that configuration was sent to an I/O unit with the legacy memory map, the point name appeared to have garbage characters at the end.

2. (KB56607) A problem has been fixed where the Inspect mode High Density Digital dialog would not recognize the new IDC-16 module.

3. (KB54041) A problem has been remedied where when sending configuration for Comm Port Control and Network Security, error 0xFFFFFFF3-Partial Success could be reported.

=====================================================================
PAC Manager R8.0a
March 1, 2007

Enhancements:
----------


2. Inspect mode Point Config, Digital Point, and Analog Point dialogs can now handle up to 32 points per module.


4. Added items to the Inspect mode Status Read page:
   Number of Times an Analog Module Has Been Discovered
   Milliseconds Per Analog & High Density Digital Scan
   Milliseconds Per 4-Channel Digital Scan

Bug fixes:
----------

1. (KB52719) The Destination field in the Maintenance dialog was being
   obscured when Download File From I/O Unit was selected.

2. (KB53351) The Find Opto MMP Devices dialog was displaying devices that
   did not have Opto's MAC address prefix.

3. (KB53350) The value of quadrature counters were always being displayed as
   unsigned values.

4. (KB54102) Copy/Paste of I/O Unit displayed "Edit PID has a bad format".

5. (KB55767) B3000-ENET, ENET-S64 and M4SENNET100 cards would not receive the
   Gateway information when assigning an IP Address.

PAC Manager R7.1c
--------------------
December 11, 2006

Bug Fixes:
----------

1. (KB51899) A problem has been fixed where Filter Weight, and Fast Settle
   Level for Load Cell modules were not being configured correctly in Inspect mode.

2. (KB53373) Calibration of analog input points now works as expected.
   Improved the feedback to the user when something goes awry.

3. A problem has been corrected where Configuring SNMP Trap Version was
   possible for all I/O Unit types when it should have only been possible for
   certain I/O Unit types.

4. Changed labeling of SNMP v2 Notification to SNMP v2 Trap.

PAC Manager R7.1b
--------------------
May 18, 2006

Enhancements:
-------------

1. (KB51463) Added the ability to synchronize the device time to the PC time
   after a firmware install.

2. Changed references to IP Ports to just Ports, and IP Security to Network
   Security.

Bug fixes:
1. (KB51648) An error is no longer reported when reading an empty flash memory image on SNAP-PAC-R1 and SNAP-PAC-R2.

2. A problem has been corrected where the Point Config Inspect mode dialog was not setting Load Cell Filter Weight and Fast Settle Level correctly.

3. The Read Filenames From I/O Unit command on the Maintenance dialog no longer returns the wrong time for each file.

4. A problem has been corrected on the I/O Unit Import/Copy dialog where the primary ip address was getting duplicated into the ip address list of the Edit I/O Unit dialog when the Image Destination was to Create a New I/O Unit.

5. The SNMP Trap Version - Notification is no longer causing an error to be reported when configuration information is sent to a SNAP-B300-ENET.

PAC Manager R7.1a
===============================================
March 8, 2006
Enhancements:
-------------

Added support for SNAP-PAC-R1 and SNAP-PAC-R2.

Bug fixes:
---------

(KB50210) A problem has been fixed where occasionally the Test Ping on the Assign IP Address dialog would just flash the screen instead of pinging the device.

PAC Manager R7.0d
===============================================
February 2, 2006
Enhancements:
-------------

1. PPP Commands in the PPP Status Inspect mode dialog can now be used with UIO and LCE devices.

2. Control Engine port has been added to the IP Security Inspect mode dialog. The default value is 22001. A value of 0 will disable the control engine.

3. Trap Version has been added to the SNMP Agent configuration. v1 Trap and v2 Notification are the supported settings.

4. An informational dialog is now displayed before attempting to install firmware via a serial connection.

5. The Previous Command info has been removed from the Status Read page.
6. All Compatible File Types is now the default mask when installing firmware on the Maintenance dialog.

Bug fixes:
-----------

1. (KB50639) A problem has been fixed where the Current Value of Input and Current Value of Setpoint items in the PID Loops Inspect mode dialog were not displaying the correct values.

2. (KB50638) A problem has been corrected where extremely high counter values were being displayed as negative numbers in the Inspect mode Digital Point and Digital Bank dialogs.

3. (KB50636) A problem has been corrected where access was being denied to Inspect mode PID Loops dialog for EIO firmware versions 6.1 to 6.1c.

PAC Manager R7.0c
===============================================
November 11, 2005

Enhancements:
-----------

1. Increased Scratchpad Floats and Integers by 7168 to 10240 elements.

2. Added PPP Commands to the PPP Status Inspect mode dialog for the SNAP-PAC.

3. Added the ability to access Comm Port Control data for the 3rd serial port on SNAP-PAC controllers.

4. Added the ability to set the Secondary Interface IP information on SNAP-PAC controllers to the Status Write Inspect mode dialog.

PAC Manager R7.0b
===============================================
September 29, 2005

Enhancements:
-----------

1. SNAP-AIMA2-i, SNAP-AIVRMS-i, SNAP-AIARMS-i modules now supported.

2. Added the ability to copy information to the clipboard in the Find Opto 22 MMP Devices dialog.

PAC Manager R7.0a
===============================================
July 28, 2005

Enhancements:
-----------

1. The Assign IP Address dialog box now supports DHCP devices such as E1 and
E2 brain boards as well as BootP devices like EIO and UIO.

2. Added the ability to find all OptoMMP (memory-mapped) devices on the network and list their MAC and IP addresses, firmware versions, and types.

3. Added the ability to use Host Names instead of IP Addresses in Inspect mode. Host Name and Domain Name were added to the Status Write dialog box.

4. Load Cell (SNAP-AILC), Profibus (SNAP-SCM-PROFI), and SNAP-AOA-23-iSRC modules now supported.

5. Added Scanner Flags setting to the Inspect mode Status Write dialog box.
   - 1 = process alarms in digital scanner
   - 2 = stop analog scanner
   - 4 = stop digital scanner
   - 8 = stop control engine

6. 32 PID Loops now available on SNAP Ultimate I/O Units with analog capability.

Bug fixes:
----------

1. IP Addresses that were very similar could sometimes be incorrectly resolved in Inspect mode. Now each IP Address has a port and timeout associated with it.

2. When installing new firmware in the Maintenance dialog box, ioManager now confirms that the device has restarted after the firmware is installed.

3. "Save to Flash" is now the default in the Send Configuration dialog box.

4. SNAP-AIRTD module now has a generic resistance mode point type.

===============================================================================
 PAC Manager R6.1a
 March 1, 2005

Enhancements:
-----------

1. Added support for High Density Digital Input and Output modules.

2. Added "Is Event Occurring?" flag to the memory map for Digital Events.

3. Added items to the Status Read dialog for diagnostic purposes:
   - TCP Idle Session Timeout Count
   - Arcnet Transmit Attempts Since Powerup
   - Arcnet ACKs
   - Arcnet Timeouts
   - Arcnet Other (node not found, etc
   - Arcnet Timeout Value (msec.)
   - Arcnet Receive Interrupts
   - Digital Interrupt Failures Since Powerup

===============================================================================

PAC Manager R6.0b
January 17, 2005

Bug fixes:
----------

1. PPP Incoming Password string in Configuration Mode is now being written to the correct memory map address.

2. PPP Modem Initialization strings can now have embedded commas.

PAC Manager R6.0a
October 1, 2004

Enhancements:
----------

1. Added hotkeys to the Turn On and Turn Off points in the Inspect Mode Digital Point dialog box.

2. Clarified menu options for installing firmware via Ethernet or serial connection.

3. Organized common communications into one button in Inspect and in Configuration modes.

4. Added Timeout fields to the I/O Unit Import/Copy dialog.

5. Modified the Modbus Address Conversion graphic to make it easier to understand.

6. Added Milliseconds Since Powerup, Ethernet MAC Resets Since Powerup, and Digital Output Points Resets Since Powerup to Inspect Mode Status Read dialog.

7. Inspect Mode now remembers the Timeout setting.

Bug fixes:
----------

1. Scratch Pad String Inspect dialog box now guards against invalid length values.

2. Installing firmware to multiple devices in the Maintenance dialog no longer results in an erroneous "Could not open local file" log message.

3. The Inspect Mode Point Configuration and Analog Point dialog boxes now display all AIPM module channels correctly.

4. ioManager will now allow you to save an empty file, including a file from which all I/O units have been deleted.

5. ioManager is now stable when reading OTG files with Digital Events.

6. You can now write to the PID module data in Inspect Mode.

7. PPP Status - Status Result for LCE devices now returns the correct status.
codes.

8. Data Logging Configuration in Inspect Mode now reads and writes to all points correctly.

9. Changing the Point Type in the Point Configuration dialog box in Inspect Mode now updates the scaling values, ensuring that subsequent calibrations to the updated point are scaled correctly.

10. Connections with latency between ioManager and the device no longer time out when attempting to read after a powerup.

===============================================================================

PAC Manager R5.1c
April 27, 2004

Enhancements:
-------------

1. Added Sync I/O Unit to PC Time feature to the Maintenance dialog.

2. Added SNAP-pH/ORP analog input module.

3. Modified the Modbus Address Conversion picture to make it easier to understand.

Bug fixes:
---------

1. All 128 digital events can now be accessed on ENET-D64, UP1-D64, and UP1-M64.

2. The memory map location of Incoming PPP Password is now F03E60B0. The PPP Phone Number can now have embedded commas and the Link Always Connected setting is now being saved to disk correctly.

3. The AIV2-i and pH/ORP modules did not display proper choices for Point Type in Inspect Mode.

4. The main window will now remember its size and position.

5. All Event Dialogs in Inspect mode are now properly disabled when accessing SNAP-LCE.

===============================================================================

PAC Manager R5.1b
December 18, 2003

Bug fixes:
---------

1. Serial Module Parity in Inspect mode can now be set to Even without it switching back to Odd when the Apply button is pressed. Also, added Mark and Space to the list of parity choices.

2. The Modbus memory map address calculator now correctly supports the full range of memory map addresses as shown in the picture.
PAC Manager R5.1a
November 14, 2003

Enhancements:
-------------

1. Added Configuration and Inspect dialogs for PID Loops.
2. Added support for Simple I/O (SNAP-ENET-S64).
3. Added Configuration and Inspect dialogs for M2M functionality.
4. Current Local IP Address was added to the display of PPP Status.
5. Login and Password strings in PPP Config were lengthened to 64 characters.

Bug fixes:
----------

1. Serial Module Config no longer clears the Hardware Flow Control byte.
2. The extended Scratch Pad areas for Integers and Floats now have the correct MemMap addresses in the Configuration and Inspect dialogs.

PAC Manager R5.0b
September 15, 2003

Enhancements:
-------------

1. Added Flash Tech Config and Status dialogs.
2. Added M2M section to Event Messages Inspect dialog.
3. Scratch Pad Floats and Integers expanded to 3072 items from 1024 items.
4. Switch To Loader Mode command added to Status Write dialog.
5. Improved Maintenance Dialog to be resizable, have colored text in the results list, and to copy a portion of a result line to the clipboard.
6. Added Ethernet Physical Link dialog.
7. In Inspect Mode, added "used" markers in the event/message number combo box to indicate which events/messages are currently configured.

Bug fixes:
----------

1. Commas are now stripped from Point Descriptions as they are written to disk.
2. Alarm Events, Digital Events, Serial Events, Timers, Wiegand Events, Event Messages, Serial Modules, Wiegand Modules, Point Config, PPP and Status Write
handle partial reads/writes of the memory map.

3. The Maintenance Dialog no longer allows duplicate IP Addresses, and the Copy button is correctly enabled when a result line is selected.

===============================================================================
PAC Manager R5.0a
July 30, 2003

Enhancements:
-------------

1. Added the ability to configure Analog Events, Digital Events, Serial Events, Timer Events, Wiegand Events, Wiegand Modules, PID Modules, Scratch Pad Bits, Scratch Pad Integers, Scratch Pad Shorts, Scratch Pad Strings, IP Security, Date and Time, Data Logging, Modbus, Status Write, and Wireless I/O Unit.

2. Added "Inspect Mode" which gives the ability to inspect and/or change any memory mapped value on an Ethernet I/O unit that can be reached over an Ethernet connection.

3. Added "Maintenance Mode" which gives the ability to perform various operations on one or more Ultimate I/O units. Operations include Install Firmware, Install Module Firmware, Upload File, Down- load file, Read Files From Flash, Write Files To Flash, and Clear Flash Files.

4. Added the ability to change the IP Address, Subnet Mask, Gateway Address, and DNS Address of an Ethernet I/O unit.

5. Added support for the SNAP-UP1-M64 I/O unit which allows analog and digital I/O on all 64 points.

Bug fixes:
-----------

1. Ultimate I/O D64 brains were not being recognized when trying to read flash memory images.

2. Changed the way that the address for where the Flash Memory Image begins is determined. Removed reliance on reading the unit type.

===============================================================================
PAC Manager R1.0c
September 12, 2002

Enhancements:
-------------

1. Detailed error and diagnostic messages are reported when an I/O Unit image is sent using the I/O Unit Import/Copy dialog.

Bug fixes:
-----------

1. Some strings were not being null terminated correctly when sent to an I/O Unit. All strings in the memory map have a specified maximum length, so the
strings must be truncated to one less than that maximum length to allow for a trailing null character. The problem could only occur on strings that were longer than the field length. Point Name, FROM E-mail Address, TO E-mail Address, E-mail Subject, SNMP Community string, and SNMP Host Community string were all incorrect. SNMP Sysname, SNMP Syslocation, and SNMP Syscontact were actually being truncated to 16 bytes when the field is 32 bytes. Modem Initialization string, Modem Hangup string, Incoming Login, Incoming Password, Modem Listen string, Outgoing Login, Outgoing Password, and Phone Number were technically incorrect but their lengths were being handled properly in the ioManager dialogs so it was highly improbable to have an error with these strings.

2. When sending I/O Unit images to Ultimate I/O units, an error occurs if there are modules that exist in the image that are not present on the I/O unit. This error was causing the operation to be aborted. Now, the operation continues, and errors are logged and displayed at the end of the operation.

3. When reading an I/O Unit image from a file, the number of characters to be read in was not being checked against the number of characters that were actually read in. If these two numbers are different, it indicates a corrupt I/O Unit image file. This error is now reported.

4. The I/O Unit Import/Copy dialog would sometimes allow the Create I/O Unit radio button to be selected even though other choices on the dialog had disabled that button.

===============================================================================

**PAC Manager R1.0b**

November 12, 2001

Bug fixes:

--------

1. Removed calls that were causing computers without Microsoft Office installed to display error messages when reading and sending brain images.

2. Changed how analog point information is sent. No scaling is sent for non-scalable points. Gain and Offset are no longer sent since it might wipe out previous calibration.

3. Fixed PPP Configuration strings, which were not being cleared correctly before being initialized by ioManager. This resulted in random characters at the end of strings in the PPP Configuration.

4. Gateway and DNS addresses were not being sent correctly to Ultimate I/O brains in the Assign IP Address dialog box.

===============================================================================

**Windows NT Installation Notes:**

----------------------

Windows NT users must have write access to the registry and the WinNT\System32 directory to successfully install and use this product.

===============================================================================

**Uninstallation of this Product:**

----------------------

A utility is provided to uninstall this product. The utility will remove all registry entries and files previously installed with the following exceptions:

- The installation directory tree is not removed if any user-created files exist in it. - The Win95/Win98 program folder or Windows NT program group is not removed if any icons have been added by the user.

**OptoDataLink**
**OptoDataLink R9.2a**
PAC Project R9.2000
March 9, 2012

**Known Issue:**

**KB81917** While running on a Windows 7 64-bit machine, OptoDataLink R9.1a and R9.2a may crash after you have initiated a successful link, stopped it, and then attempted to restart the same link. This issue does not occur on Windows XP, Vista, or Win7 32-bit.

**OptoDataLink R9.1a**
PAC Project R9.1000
July 18, 2011

**Bug Fix:**

**KB80298** OptoDataLink data update may fail with quick strategy tag updates.

**KB81229** Data Link stored late to Destination by OptoDataLink.

**OptoDataLink R9.0a**
PAC Project R9.0000
June 17, 2010

**Bug Fix:**

**KB80978** OptoDataLink does not exchange data if 'depending on Combination' is selected.

**OptoDataLink R8.2b**
PAC Project R8.2003
September 5, 2008

**Enhancements**

* When you click the play or stop button in Configurator, OptoDataLink will start the Runtime service if it is not already started. Previously, this would result in a confusing error message.

* The Edit dialog box where you choose a strategy variable now only shows read-only or write-only tags when they are appropriate. For example, since tags used
in the Opto 22 Device Destination must be able to be written to, read-only tags do not appear in the tag tree dialog.

=====================================================================  
OptoDataLink R8.1a  
PAC Project R8.1000  
October 8, 2007  
Version update to match the 8.1 release. No changes.

=====================================================================  
OptoDataLink R8.0d  
PAC Project R8.0010  
July 20, 2007  
Bug Fixes  
* (KB58201) A problem has been corrected where when the Opto 22 Device data source started up, it immediately exchanged data. This is correct for the interval timer, but not for the Time Of Day timer. There was a data exchange each time the link was started, not just at the correct time of day.  
* (KB58200) A problem has been corrected where the Time of Day timer was not always advancing to the next day, and sometimes would not shut off.  
* (KB58482) A problem has been corrected where when multiple data links had conditions based on a value on an Opto 22 Device, only the first link with such a condition would ever exchange data.

=====================================================================  
OptoDataLink R8.0c  
March 23, 2007  
New Features  
* The error viewing window now supports saving the errors to a text file.

Enhancements  
* Connections to the controller are pooled if multiple sources, destinations, and conditions need to communicate with devices.  
* The Database source, destination, and condition reconnect to the database if the connection stops working. The connection may stop working if the database is stopped, or a network connection goes away.  
* Fixed memory leaks when data links are running.

=====================================================================  
OptoDataLink R8.0b  
March 9, 2007  
Bug Fix:  
* (KB56343) A problem has been fixed where when an Opto 22 device was a source and the data link used a condition, only the first data exchange would happen
reliably. If the data on the device didn't change when the flag was true, no data exchange would happen.

---

**PAC Utilities**

Version R8.2a  
June 19, 2008

=====================================================================  

To better support PAC Terminal's graphical user interface (GUI) and command line (CL) modes, they are now separate programs.

- Term.exe provides the GUI version of PAC Terminal.
- TermCL.exe provides the command line version of PAC Terminal.

In addition, a new version of PAC Terminal called PAC Terminal SSD provides Secure Strategy Distribution (SSD) capability, which allows strategies to be downloaded and stored on a controller in a secure manner using encryption:

- TermSSD.exe provides the GUI version of PAC Terminal SSD.
- TermCLSSD.exe provides the command line version of PAC Terminal.

PAC Terminal SSD is available for purchase from Opto 22's website or a member of the worldwide network of Opto 22 authorized distributors and partners.

---

**PAC Utilities R8.1a**  
October 10, 2007

PAC Terminal has received a significant amount of user interface improvements. Highlights of the improvements include:

* The main window's list of controllers adds several columns of information, including primary and secondary addresses and current status. Also, the columns are now sortable.

* The main window now has a task panel for common operations.

* The main window can now scan controllers for their current status.

* The View Message Queue window now has a Refresh button to quickly refresh the list of messages. Also, the new Copy All button copies all of the messages into the clipboard.

* The Terminal window has been cleaned up.

* The Inspect Controller window has been cleaned up and now supports Background Strategy Downloads. Also, the communication loop time is now much more accurate.

---

**PAC Utilities R7.1c**  

====================================================================
May 18, 2006

ioCom.dll is now version R7.1c

1. (KB50320) Corrected a problem in the View Messages dialog. Incorrect results would be shown if a chart's name was longer than 35 characters.

2. In the Inspecting Control Engine dialog, added a field to show how many charts are currently running.

PAC Utilities R7.1b
============================

April 7, 2006

(KB51140) OptoVersion was updated to include ioProject Professional and Basic executable files.

PAC Utilities R7.1a
============================

February 15, 2006

(KB49973) Corrected a problem that could prevent OptoENETSniff from loading a log file, instead reporting the error: "Invalid Log File Error Type mismatch; Error in function LoadFile. Invalid log file. Error code 13."

PAC Utilities R7.0b
============================

January 19, 2006

1. When using one of ioTerm's command line options, it now returns an error code to indicate success or failure. It also provides a -q option to prevent any dialog boxes from being shown.

2. In the Inspect Control Engine dialog box, added user confirmation to the Run and Stop buttons.

PAC Utilities R7.0a
============================

December 11, 2005

1. ioTerm now supports the secondary network interface found on SNAP PAC products.

2. ioMessageViewer is now more responsive when logging to a file and the screen at the same time.
PAC Utilities R6.0a
===========================================

October 1, 2004

1. ioTerm no longer includes the Clear ioDisplay Words option, which is obsolete for ioDisplay versions R5.1 and newer.

2. ioMessage Viewer (formerly ioSnif.exe) now supports logging to multiple files. Multiple files can be helpful when sniffing for longer periods of time. Filenames are automatically generated and stored in a subdirectory based on the date and time logging begins.

3. ioMessage Viewer now allows you to disable on-screen updates while logging. Disabling on-screen updates reduces the resource usage so the sniffing itself will have less impact on the behavior you're recording. See File->Settings.

4. OptoEnetSniff is now included as part of ioUtilities for the R6.0a release.

OptoEnetSniff R6.0a Enhancements
--------------------------------

* Added an option in OptoEnetSniff to specify the number of buffers to save (as a file to the hard drive). This avoids unintentional overwriting by creating a folder for the new multiple files created. Folder and files are named according to time and date. (Example: 2004.09.01_09.48.45\netmon2004.09.01_09.48.48-2.log)

* Increased allowable buffer size to 256 MB.

* Now OptoENETSniff remembers your preferences for adapter card selected, display colors, and buffer settings.

* Added menu keyboard shortcuts for easier navigation without a mouse.

* Increased the maximum number of characters in the Name field to allow IP addresses to be used as names.

* The adapter selection is more flexible. It will now allow the user to select a 0.0.0.0 IP address. (0.0.0.0 appears as "unknown.")

OptoEnetSniff R6.0a Bug Fixes
----------------------------

* Corrected bug that caused the application to crash when no IPs were selected for filtering.

* Adapter card information is now read more reliably.

* Corrected red error indicator that incorrectly appeared in logs opened after a log with an error. The indicator incorrectly showed up on the same row as the previous log's error, even though no errors occurred on the frame in the new log.

* Corrected bug that sometimes occurred after clicking the Stop Capture button.


* Corrected bug that sometimes occurred if the Stop Scan button was clicked while attempting to capture packets. The bug caused the message "Error in function Loadfile. Invalid log file. Error code: 0" to appear if no packets were captured.

**PAC Utilities R5.0a**

=================================

July 29, 2003

1. ioTerminal displays the date, time, and strategy object associated with any error or notification message.

2. ioTerminal no longer includes the Clear ioDisplay Words option, which is obsolete for ioDisplay versions R5.1 and newer.

**PAC Utilities R1.0c**

=================================

August 16, 2002

1. Each line in an ioMessageViewer log now has a unique line number.

2. Added filtering to ioMessageViewer.

3. In ioMessageViewer, the client's name is now included on each line.

4. Added a timestamp to mark when logging to a file has started or stopped.

5. Added support to ioTerminal for ioControl's new Control Engine Download File feature.

6. Added command line arguments to ioTerminal for adding a control engine, downloading a file, and running and stopping a strategy.

7. Made a few GUI tweaks to make ioTerminal easier to use with a keyboard. The control engine inspect dialog now has a close button that is the default. Also, selecting a control engine and hitting Enter will now open the inspect dialog, rather than closing ioTerminal.

**PAC Utilities R1.0a (002)**

=================================

September 7, 2001

1. The "Inspect Control Engine" dialog in ioCom.dll has a new look. It also has two new fields, "Revision Time" and "Persistent RAM".

2. The "Inspect Control Engine" dialog in ioCom.dll now uses a different method for determining the communications loop time. It now displays the time taken for one single transaction, rather than several.
3. OptoVersion was not scanning directories that had the archive, hidden, compress, or hidden flags set.

What's included in ioUtilities?

----------------------------------------

ioTerm.EXE, ioMessageViewer.EXE, OptoVersion.EXE, AND OptoENETSniff.EXE

ioTerminal (ioTerm.exe)
-------------
ioTerminal.EXE may be used to create and test communications to control engines. When it starts, it displays a list of control engines configured on your computer. ioTerminal is used to:
* view a status dialog for a control engine
* interactively 'talk' to a control engine for diagnostic purposes
* add and configure control engines

ioMessage Viewer (ioMessageViewer.exe)
-------------
ioMessage Viewer is used to monitor communications at various levels in the communications drivers. Normally, ioMessage Viewer is used with the help of Opto 22 Product support personnel. Select 'View/monitor levels' to enable or disable various monitor levels.

OptoVersion.EXE
-------------
OptoVersion is a quick utility that will come in handy when you are talking with our Product Support staff. OptoVersion searches your local hard drives and reports back all the Opto 22 DLL and EXE files that you have, including their versions and paths. If Product Support needs to see the list, the utility sets it up for easy emailing.

OptoEnetSniff.EXE (OptoEnetSniff.exe)
-------------
OptoENETSniff is a network communication analysis tool that captures Ethernet frames and stores them in a log for analysis. You can capture a log manually or use an automatic timer. Additional features are:
* Advanced Scripting for Visual Basic users.
* Display options
* Tracing routes
How to Get Help

If you have any questions about this product, contact Opto 22 Product Support Monday through Friday, 7 am to 5 pm, Pacific Time.

Email: support@opto22.com
Phone: 800-TEK-OPTO (835-6786) or 951-695-3080
Fax: 951-695-3017
Opto 22 website: www.opto22.com

Please provide the following information about your system to the Product Support engineer:

- Version of this product
- PC configuration (type of processor, speed, memory, operating system)
- A complete description of your hardware system, including:
  - jumper configuration
  - accessories installed (such as daughter cards)
  - type of power supply
  - types of I/O units installed
  - third-party devices installed (e.g., bar code readers)
  - Controller firmware version
- Any specific error messages seen